USER'S MANUAL FOR MacPASCO

S. H. Lucas
R. C. Davis

FEBRUARY 1992

NASA
National Aeronautics and Space Administration
Langley Research Center
Hampton, Virginia 23665
# User's Manual for MacPASCO

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossary</td>
<td>1</td>
</tr>
<tr>
<td>Overview</td>
<td>2</td>
</tr>
<tr>
<td>The Screen Display</td>
<td>4</td>
</tr>
<tr>
<td>The Tool Palette</td>
<td>6</td>
</tr>
<tr>
<td>- The Point-hand Tool</td>
<td>6</td>
</tr>
<tr>
<td>- Selecting Plates</td>
<td>6</td>
</tr>
<tr>
<td>- Displaying Plate Information</td>
<td>7</td>
</tr>
<tr>
<td>- Modifying Plate Width and Rotation</td>
<td>8</td>
</tr>
<tr>
<td>- How Changing Plate Dimensions Affects Other Plates</td>
<td>9</td>
</tr>
<tr>
<td>- Making Plate Width an Optimization Design Variable</td>
<td>10</td>
</tr>
<tr>
<td>- Displaying Node Information</td>
<td>10</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>11</td>
</tr>
<tr>
<td>The Grab-hand Tool</td>
<td>12</td>
</tr>
<tr>
<td>- Selecting Plates</td>
<td>12</td>
</tr>
<tr>
<td>- Moving Plates</td>
<td>12</td>
</tr>
<tr>
<td>- Changing Plate Dimensions</td>
<td>13</td>
</tr>
<tr>
<td>The Add-Node Tool</td>
<td>14</td>
</tr>
<tr>
<td>The Add-Plate Tool</td>
<td>14</td>
</tr>
<tr>
<td>The Add-Loop Tool</td>
<td>15</td>
</tr>
<tr>
<td>- How Closed Sections carry Transverse Loads</td>
<td>16</td>
</tr>
<tr>
<td>The Magnifying Glass Tool</td>
<td>16</td>
</tr>
<tr>
<td>The Delete-Node Tool</td>
<td>17</td>
</tr>
<tr>
<td>The File Menu</td>
<td>18</td>
</tr>
<tr>
<td>- Selecting Menu Options</td>
<td>18</td>
</tr>
<tr>
<td>- File Dialog Boxes</td>
<td>18</td>
</tr>
<tr>
<td>- Switching Disks</td>
<td>19</td>
</tr>
<tr>
<td>- Cancel</td>
<td>19</td>
</tr>
<tr>
<td>- New</td>
<td>19</td>
</tr>
<tr>
<td>- Open</td>
<td>19</td>
</tr>
<tr>
<td>- Selecting and Opening a File</td>
<td>20</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Finding the File to Open</td>
<td>20</td>
</tr>
<tr>
<td>Make PASCO Code</td>
<td>20</td>
</tr>
<tr>
<td>The Generated PASCO Input</td>
<td>20</td>
</tr>
<tr>
<td>Close</td>
<td>21</td>
</tr>
<tr>
<td>Save</td>
<td>21</td>
</tr>
<tr>
<td>Save As</td>
<td>21</td>
</tr>
<tr>
<td>Save a Copy In</td>
<td>22</td>
</tr>
<tr>
<td>Page Setup</td>
<td>22</td>
</tr>
<tr>
<td>Print One... and Print...</td>
<td>22</td>
</tr>
<tr>
<td>Print</td>
<td>22</td>
</tr>
<tr>
<td>Print One</td>
<td>23</td>
</tr>
<tr>
<td>Quit</td>
<td>23</td>
</tr>
<tr>
<td>The Edit Menu</td>
<td>24</td>
</tr>
<tr>
<td>Undo</td>
<td>24</td>
</tr>
<tr>
<td>Redo</td>
<td>24</td>
</tr>
<tr>
<td>Can't Undo</td>
<td>24</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td>24</td>
</tr>
<tr>
<td>The View Menu</td>
<td>25</td>
</tr>
<tr>
<td>Zoom In and Zoom Out</td>
<td>25</td>
</tr>
<tr>
<td>Scale Current View</td>
<td>25</td>
</tr>
<tr>
<td>The Difference Between Scaling and Zooming</td>
<td>26</td>
</tr>
<tr>
<td>Show Plate Numbers</td>
<td>26</td>
</tr>
<tr>
<td>The Panel Menu</td>
<td>27</td>
</tr>
<tr>
<td>Apply Panel Loads</td>
<td>27</td>
</tr>
<tr>
<td>Panel Length</td>
<td>28</td>
</tr>
<tr>
<td>Mx</td>
<td>28</td>
</tr>
<tr>
<td>Nx</td>
<td>28</td>
</tr>
<tr>
<td>Nxy</td>
<td>28</td>
</tr>
<tr>
<td>Ny</td>
<td>28</td>
</tr>
<tr>
<td>Pressure</td>
<td>28</td>
</tr>
<tr>
<td>EigenValues</td>
<td>29</td>
</tr>
<tr>
<td>λ</td>
<td>29</td>
</tr>
<tr>
<td>Specific Eigenvalues</td>
<td>29</td>
</tr>
</tbody>
</table>
NUMBER OF REPEATING ELEMENTS ............................................................... 30
SHOW ENTIRE PANEL .............................................................................. 31

THE LAMINATE MENU .............................................................................. 32
DEFINE PLY MATERIALS .......................................................................... 32
CREATING AND MODIFYING PLY MATERIALS ........................................... 33
MATERIAL FAILURE CRITERION AND ALLOWABLES ................................. 34
DEFINE PLYS ............................................................................................ 34
CREATING AND MODIFYING PLYS ............................................................. 35
DEFINE LAMINATES ............................................................................... 36
CREATING AND MODIFYING LAMINATES ............................................... 37
ASSIGN LAMINATES TO PLATES ......................................................... 38
OPEN LAMINATE FILE ............................................................................. 39
SAVE LAMINATE FILE ........................................................................... 40

THE OPTIMIZATION MENU ....................................................................... 41
SIZING CYCLES .......................................................................................... 41
LINKING EQUATIONS .............................................................................. 41
ADDING VARIABLES TO LINKING EQUATIONS ....................................... 43
ADD PLATE WIDTH .................................................................................. 43
ADD PLY THICKNESS ............................................................................. 44
ADD PLY ANGLE ...................................................................................... 44
ADD RIGHT HAND SIDE ......................................................................... 45
MODIFYING VARIABLE COEFFICIENTS OR THE RIGHT HAND SIZE .......... 45
DEPENDENT AND INDEPENDENT VARIABLES ..................................... 46
DESIGNATING DEPENDENT VARIABLES .............................................. 47
DELETING VARIABLES FROM A LINKING EQUATION ................................ 47
CHANGING LINKING EQUATIONS ........................................................ 48
SHOW ALL EQUATIONS .......................................................................... 48

EXAMPLE 1: LAMINATED UNSTIFFENED PLATE ..................................... 49
EXAMPLE 2: BLADE STIFFENED PANEL .................................................. 65
EXAMPLE 3: HAT STIFFENED PANEL .................................................... 86
REFERENCES ............................................................................................ 98
Glossary

The glossary below defines terms used throughout this manual. Most of these terms find common use for discussions of the Apple Macintosh computer’s user interface.

**button**  
A button is a small screen object, usually labeled with text. The user clicks on a button to cause the computer to perform an action.

**check box**  
A check box represents an option that is either on or off. The user clicks on the check box to alternate between the options.

**click**  
To position the cursor on the computer screen, and then to press and quickly release the mouse button.

**cursor**  
A small screen object that follows the movement of the mouse on the screen.

**dialog box**  
A display window which prompts the user for input. A dialog box remains on the screen until the user dismisses it, usually by pointing to a button-shaped object within the dialog box display and clicking.

**double-click**  
To click twice in rapid succession without moving the mouse between clicks.

**drag**  
To position the cursor on the screen, press and hold the mouse button down, move the cursor with the mouse button down to a new location on the screen, and release the mouse button.

**mouse**  
Generic term for any hand-operated interface device that controls the location of the cursor on the computer screen. The mouse has a button which is pressed by the user, usually to signal the computer to initiate an action.

**point**  
To use the mouse to indicate a location on the screen.

**pop-up menu**  
A menu which is accessed via a dialog box or window, as opposed to a pull-down menu which is accessed via the menu bar at the top of the screen. Only the currently selected menu option is visible; the full range of menu options appear (i.e., *pops-up*) when the user points to the displayed option and presses the mouse button.

**pull-down menu**  
A menu which is accessed via the menu bar at the top of the screen. The menu bar lists only the menu names; the full menu becomes visible (i.e., *pulls-down*) when the user points the menu name and presses the mouse button.
MacPASCO is an interactive, graphic preprocessor for stiffened panel structural design. MacPASCO creates input for PASCO (refs. 1 and 2), an existing computer code for structural analysis and minimum-mass optimization of longitudinally-stiffened composite panels.

MacPASCO's graphical interface simplifies the specification of panel geometry and reduces user input errors, thus making modeling and analysis of panel designs more efficient. The user draws the geometry of a structural panel cross section on the computer screen. Then a combination of graphic and text inputs is used to refine the structural geometry, to specify information required for analysis such as panel load conditions, and to define design variables and constraints for minimum-mass optimization.

PASCO uses a linked-plate representation of geometry in which individual flat plates are assembled to construct a structural panel cross section. Two or more individual plates are assembled to form a substructure, which is repeated to create the entire panel cross section. A plate is constructed as a balanced symmetric laminate of a prescribed number of plies with orthotropic material properties. The two figures below illustrate this modeling technique.

The left-hand figure above shows a hat-stiffened structural panel and the global panel coordinate system X, Y, Z. Boundary conditions are placed on the lateral (X axis) edges of the panel by constraining the rotation \( \theta \) and displacements \( w, v, u \). The right-hand figure shows a hat-stiffener substructure which is repeated three times to form the cross section of the panel on the left. Six plates are assembled to form the hat-stiffener substructure.
Structural modeling with MacPASCO follows PASCO's modeling technique. MacPASCO displays a drawing window in which the user creates a substructure like that shown in the right-hand figure above. MacPASCO's graphical tools allow the user to manipulate plates on the computer screen to create the desired substructure.

This manual is a guide for the use of MacPASCO, and a reference document which contains a comprehensive list of all of MacPASCO's features. Some knowledge of the PASCO code is required to use MacPASCO effectively, since MacPASCO only produces the input for PASCO. PASCO is used subsequently to actually perform the structural analysis and sizing using the input MacPASCO generates. The PASCO code is described in references 1 and 2. In addition, a stand-alone Macintosh version of the PASCO code, which can be used alone or in conjunction with MacPASCO, is described in reference 3. An earlier version of MacPASCO is described in reference 4.
MacPASCO's interface consists of a drawing window which displays a drawing of a panel cross section. A tool window contains a palette of graphical tools which are used to create and manipulate the displayed cross section. A menu bar across the top of the screen allows for other inputs required for structural panel analysis and sizing. The MacPASCO interface is consistent with the Apple Macintosh computer interface guidelines for windows, scroll-bars, pull-down menus, dialog boxes, and other Macintosh interface features. In this way, MacPASCO shares features common to many Apple applications.

MacPASCO's initial screen display is shown below:

The drawing window displays a view of the cross section which is repeated to form the stiffened panel. The displayed cross section initially consists of a single flat plate. The display shows the boundary conditions on the panel edges. Initially, the panel edges are free as indicated by the annotation, $f_1$, on the end nodes of the cross section.

A message box, labeled "Plate Information," displays plate width and rotation as plates are manipulated on the screen. In this manual, the term rotation means the orientation of a plate in the structural geometry. Use of the term rotation to denote a degree of freedom is explicitly noted in the text. Message box entries are dimmed when inactive, in accordance with Apple Macintosh computer conventions. The tool palette window displays small pictures of various tools used to draw and manipulate the section graphically. These tools are described in detail in another section of this manual.
The menu bar at the top of the screen displays a range of options, grouped by function. Only the name of each menu appears; the full menu pulls-down when the user points to the menu name and holds the mouse button down. For example, the pull-down view of the Optimization menu is shown below:

```
Optimization

Sizing Cycles
Linking Equations
```

To choose an item from a pulled-down menu, drag the mouse pointer from the menu name down to the item and release the mouse. The Optimization menu allows the user to define the number of sizing cycles during optimization and to define linking equations. Menu options are discussed in detail in another section of the manual.
The Tool Palette

The tool palette is a floating window containing small pictures, called icons, of various tools. The palette is a floating window because it always remains in front of any other MacPASCO window so that the tools are always visible and available. The tool palette can be moved around the screen like any other window.

The tools are used to draw and manipulate the cross section displayed in the drawing window. Tools are selected by clicking on the tool's icon with the mouse. The icon for the currently selected tool is always darkened, indicating which tool has been selected. In addition, when the cursor is over the MacPASCO drawing window, the cursor usually changes to reflect the currently selected tool.

There are seven tools available in the current version of MacPASCO: a point-hand tool, a grab-hand tool, an add-node tool, an add-plate tool, an add-loop tool, a magnification tool, and a delete-node tool. Each tool and its function are discussed in the sections that follow.

The Point-hand Tool

The point-hand tool is represented by a point-hand icon, as seen on the left. When the point-hand tool is selected, the cursor changes to look like the point-hand icon. This tool has two functions:

- To select plates in the current cross section.
- To display a dialog box containing information about a plate or node in the current cross section.

Selecting Plates

- To select a plate with the point-hand tool, place the index finger part of the cursor over a plate and click once. The selected plate darkens to show it has been selected, and previously selected plates are deselected. The plate's width and rotation are displayed in the drawing window message box.

- To select more than one plate, hold down the keyboard shift-key while clicking on each plate. Each selected plate darkens to show it has been selected. The width and rotation for the most recently selected plate appears in the drawing window message box.
• Another way to select a plate or plates with the point-hand tool is to press the mouse button and drag the mouse with the mouse button depressed. A shimmering rectangle appears on the screen. When the mouse button is released, plates inside the rectangle are selected, and the rectangle disappears. A plate must be completely inside the rectangle to be selected. Once again, the shift-key can be used to make multiple selections with the shimmering rectangle. The shift-key must be held down before clicking and dragging the mouse, or previously selected plates are deselected.

**Displaying Plate Information**

To display information about a plate, simply place the index finger part of the cursor over a plate and double-click. A dialog box appears on the screen displaying information about the plate such as its width and rotation as shown below:

![Plate Information Dialog Box]

The plate information display contains the following:

- The plate width which can be edited to a numerically precise value.
- A "Design Variable" check-box which makes the plate width an optimization design variable and allows a lower and upper bound to be prescribed for the plate width during optimization.
- The plate width's lower and upper bounds which can be edited when the plate width is an optimization design variable.
- The plate rotation which can be edited to a numerically precise value.
- The name of the laminate associated with the plate. The laminate name cannot be changed with the plate information display and is initially undefined. The laminate is assigned using the Assign Laminates to Plates option of the Laminates menu.
- A "Lock Plate Geometry" check-box. When the check-box is selected, the plate width and rotation are unchanged when adjacent plate width and rotation are altered via their Plate Information dialog boxes. If "Lock Plate Geometry" is not selected, the plate dimensions change to accommodate changes in adjacent plate width and rotation.

Each item of the plate information display is discussed in subsequent sections of this manual.
Modifying Plate Width and Rotation

The plate information dialog box is used to change plate width or rotation. Select the value to be modified, and type in the new value. The keyboard TAB key can be used to move quickly from value to value. The mouse can also be used to make selections manually, but the TAB key is usually faster than the mouse because it automatically selects each value when switching fields. To select a value with the mouse, click on the current value and a bar cursor, |, appears. The value can be modified in the usual way, backspacing to delete, typing new text, using the arrow keys to move the cursor, and using the mouse to select parts of the value to be replaced or deleted.

**WARNING**

The current version of MacPASCO does not check to see whether or not the new width and rotation entered via the Plate Information dialog box makes the plate exceed the viewing area boundaries. For example, consider a plate at the very top of the scrollable viewing area. Giving this plate a long width and a rotation of 90 degrees grows the plate beyond the viewing area. This situation is shown in the figure below:

![Plate Information Dialog Box](image)

Errors are likely to result. Two steps can be taken to avoid this situation:

1. Use the grab-hand tool to move the section so that there is room for plates to grow before modifying the plate widths and rotations. The grab-hand tool is discussed in the next section of this manual.

2. Scale the viewing area properly. The viewing area can be made large enough for most cross sections by using the proper scale for the viewing area. With the proper scale, the problem of over-large plates can be avoided. Scaling the view area is discussed in another section of this document.
How Changing Plate Dimensions Affects Other Plates

Altering a plate's width or rotation via the Plate Information dialog box does not affect the width or rotation (geometry) of other plates. If a plate width or rotation is changed via a dialog box, the final node of the plate moves to accommodate the change, as seen in figure a. below. Any other plates connected to the final node are also shifted, and the shift propagates through the cross section (figure b), which insures that the geometry of these other plates remains the same.

Exception: An exception occurs when the cross section contains a loop or cycle, such as the triangle shape in the figures above. In such a loop, the width of one plate in the loop cannot change and still hold the widths of the other plates fixed. An error message results. In these cases, the width of one of the plates in the loop must change to accommodate the altered plate. If a change in a plate's width is attempted without unlocking another plate in the loop, the following error message appears:

![Error Message]

This plate's width and/or rotation cannot be adjusted without altering a rigid plate

The box labeled Lock Plate Geometry in the upper right corner of the Plate Information dialog box is used for these situations. Clicking in the box unlocks the plate, allowing the plate to change dimension to accommodate changes to adjacent plates. When a plate is locked, a cross (X) appears in the lock plate check box.

In the example below, the plate forming the right side of the triangle has been unlocked and the width of the plate forming the left side of the triangle is increased.

![Diagram]

When the plate forming the left side of the triangle gets longer, the unlocked plate forming the right side of the triangle changes dimension to accommodate the change.
Initially, all plates are locked, so that altering a plate's width or rotation does not affect the geometry of other plates. The Lock Plate Geometry check-box is used to make one or more plates flexible, typically for the case of a loop.

Making Plate Width an Optimization Design Variable

The plate information dialog box is also used to make the plate width a design variable. The square labeled "design variable" (in the plate information dialog box shown previously) is a check box. When a cross, X, appears in the check box, the plate width is a design variable during optimization. When no cross appears, the plate width is not a design variable. If the plate width is not a design variable, clicking on the check box makes the plate width a design variable. If the plate width is a design variable, clicking on the check box makes the plate width not be a design variable. The upper and lower bound fields are disabled when the plate width is not a design variable.

Displaying Node Information

To display information about a node, place the cursor over the node and click once. The following dialog box appears:

The node information display consists of the following:

- The node number used in the PASCO output is shown but cannot be edited.
- A pop-up menu which displays the current boundary condition on the node, and allows the boundary conditions on the nodes at the edges of the panel to be changed.
- Three indicators show whether the node is on a panel edge or in the interior. The node on the left edge of the panel is the start node, the node on the right edge is the final node.

Each node is numbered; the node number appears in the upper left-hand corner of the dialog box. The darkened circle under node information indicates whether the node is the start node, final node or interior node of the cross section. In the example above, the node is a final node. Finally, a pop-up menu in the upper right-hand corner of the dialog box specifies the boundary conditions on a node. Clicking on the menu with the mouse displays a range of possible boundary conditions. The start node's boundary conditions apply to the entire left edge of the panel, the boundary condition on the final node apply to the entire right edge of the panel. Each boundary condition is discussed in the next section of this manual.
Boundary Conditions

Clicking on the boundary condition pop-up menu reveals the list of possible boundary conditions. To select a boundary condition for the panel, click and hold the mouse button down over the boundary condition pop up menu of the node information dialog box. Keep the mouse button depressed and drag the mouse over the desired menu choice. Release the mouse button and the boundary condition beneath the mouse becomes the new boundary condition for the panel edge.

The boundary condition pop-up menu is shown at the left below. A table which describes the constraints implied by each boundary condition appears on the right. The rotation being constrained is a degree freedom at the node.

<table>
<thead>
<tr>
<th>Boundary Condition</th>
<th>Rotation [X-axis]</th>
<th>Displacement w</th>
<th>Displacement v</th>
<th>Displacement u</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free (F1)</td>
<td>free</td>
<td>free</td>
<td>free</td>
<td>free</td>
</tr>
<tr>
<td>F2</td>
<td>free</td>
<td>free</td>
<td>free</td>
<td>Constrained</td>
</tr>
<tr>
<td>F3</td>
<td>free</td>
<td>free</td>
<td>Constrained</td>
<td>free</td>
</tr>
<tr>
<td>F4</td>
<td>free</td>
<td>free</td>
<td>Constrained</td>
<td>Constrained</td>
</tr>
<tr>
<td>Simple Support (SS1)</td>
<td>free</td>
<td>Constrained</td>
<td>free</td>
<td>free</td>
</tr>
<tr>
<td>SS2</td>
<td>free</td>
<td>Constrained</td>
<td>free</td>
<td>free</td>
</tr>
<tr>
<td>SS3</td>
<td>free</td>
<td>Constrained</td>
<td>Constrained</td>
<td>free</td>
</tr>
<tr>
<td>SS4</td>
<td>free</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
</tr>
<tr>
<td>Symmetry (S1)</td>
<td>Constrained</td>
<td>free</td>
<td>free</td>
<td>free</td>
</tr>
<tr>
<td>S2</td>
<td>Constrained</td>
<td>free</td>
<td>Constrained</td>
<td>free</td>
</tr>
<tr>
<td>S3</td>
<td>Constrained</td>
<td>Constrained</td>
<td>free</td>
<td>Constrained</td>
</tr>
<tr>
<td>S4</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
</tr>
<tr>
<td>Clamped (C1)</td>
<td>Constrained</td>
<td>Constrained</td>
<td>free</td>
<td>free</td>
</tr>
<tr>
<td>C2</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
<td>free</td>
</tr>
<tr>
<td>C3</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
<td>free</td>
</tr>
<tr>
<td>C4</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
<td>Constrained</td>
</tr>
</tbody>
</table>

Displacements $w$, $v$, $u$, and rotation $\theta$ are relative to the global panel coordinate system $X$, $Y$, $Z$ shown at the left.

The table summarizing each boundary condition is shown to the right in the figure above. Note that SS3 is the classical simple support boundary condition and C3 is the classical clamped boundary condition. In MacPASCO, boundary conditions can ONLY be applied at the start or final node, and the three displacements are relative to the overall panel coordinate system (shown at the bottom of the figure above), rather than to the local plate.
The boundary conditions specified at the start and final nodes apply to the entire panel. Thus to specify a boundary condition on the left-hand edge of the panel shown above, one must select the start node and specify a boundary condition. Likewise, boundary conditions on the right-hand edge are selected by specifying the correct boundary conditions from the final node's pop-up menu.

The Grab-hand Tool

The grab-hand tool is represented by an open hand icon, as seen on the left. When the grab-hand tool is selected, the cursor changes to an open hand cursor that looks like the open hand icon. This tool has three functions:

- It can be used to select plates in the current cross section.
- It can be used to move plates in the current cross section.
- It can be used to change the dimensions of plates in the current cross section.

Selecting Plates

Plate selection with the grab-hand tool is identical to plate selection with the point-hand tool. However, unlike the point-hand tool, the grab-hand tool can also move a plate or change its dimensions. Thus when the grab-hand tool is used to make selections, it is possible to move accidentally a plate or change its dimensions. Consequently, the point-hand tool is usually used to select plates in order to avoid such accidental changes.

- Center the palm of the hand cursor over a plate and click once (The small cross in the cursor palm can be used as a guide). The selected plate darkens when selected and any previously selected plates are deselected. The plate's width and rotation are displayed in the drawing window message box.

- To select more than one plate, hold down the keyboard shift-key while clicking on each plate. Each selected plate darkens when selected. The width and rotation for the most recently selected plate appears in the drawing window message box.

- Another way to select a plate or plates with the grab-hand tool is to press the mouse button and drag the mouse with the mouse button depressed. A shimmering rectangle appears. When the mouse button is released, any plates inside the rectangle are selected and the rectangle disappears. A plate must be completely inside the rectangle to be selected. Once again, the shift-key can be used to make multiple selections with the shimmering rectangle. The shift-key must be held down before clicking and dragging the mouse, or all previously selected plates are deselected.

Moving Plates

It is sometimes convenient to move plates, usually to move the current cross section into a more accessible location in the drawing window. To move one or more plates, do the following:

1. Select the plates to be moved either using the point-hand tool or the grab-hand tool.
2. Point to a selected plate, press the mouse button and drag the mouse with the mouse button still depressed.

All the selected plates move to follow the movements of the mouse. The widths and rotations of the selected plates are not changed by the move. Plates connected to the moving plates change dimension to accommodate the movement, as seen in the figure below:

- Notice that moving plates does not affect connectivity (how the plates are attached to one another) but can change the width and rotation of plates connected to the moving plates.

- Plate movements can be undone immediately after the move by selecting the Undo option of the Edit menu. Thus if one moves a collection of plates and realizes the movement was a mistake, one can select "undo" to restore the plates to their original locations. However, the "undo" action must be taken before attempting any other actions or switching tools. For example, if plates are moved, and then the point-hand tool is selected, undoing the movement is no longer possible.

**Changing Plate Dimensions**

The grab-hand tool can be used to change plate dimensions by grabbing and dragging nodes. To change a plate's dimensions:

Point to a node, press the mouse button and drag the mouse while keeping the mouse button pressed. All plates attached to the node change dimensions to follow the node's movement.

For example, consider the figure below:

- The drawing window message box displays the width and rotation of the plate being altered. If one or more plates are being altered, the width and rotation of the most recently selected plate is displayed.

- The option-key on the keyboard allows a plate's width to be changed without altering its rotation. To alter only plate width, hold the option-key down when clicking on the node with the grab-hand tool before dragging the node.

As with moving plates, plate dimension changes can be undone immediately afterwards by selecting the Undo option of the Edit menu. The "undo" action must be taken before attempting any other actions or changing tools. For example, if a node is moved to change plate dimensions, and then the point-hand tool is selected, undoing the movement is not possible.
The Add-node Tool

The add-node tool is represented by the icon shown at the left. The add-node tool is used to add a node to an existing plate, essentially splitting a single plate into two plates sharing a common node. When the add-node tool is selected, the cursor changes into a cross-hair cursor that looks like a large “plus” sign.

- To add a node to a plate, do the following: place the intersection of the cross-hair cursor over a plate and press the mouse button. A node is added to the plate at the cursor. Adding a node forms two new plates, one which ends with the new node and one which starts with the new node as seen in the figure below:

![Diagram showing the addition of a node to a plate]

- By dragging the mouse with mouse button depressed, one can move the new node as it is added, as shown above. The drawing window message box displays the width and rotation for the plate which ends with the new node.

- It is often useful to add a node to a plate and produce two new plates with the same rotations as the original plate. To do this, hold the Option key on the keyboard down while clicking on the plate to add a node. Dragging the mouse with the mouse button depressed moves the new node, but the rotations of the new plates are fixed, as seen below:

![Diagram showing the addition of a node with fixed rotations]

The user adds a node to a plate with the keyboard’s option-key depressed, as seen in the figure on the left. As the user drags the mouse upwards the node moves, but the rotations of the two new plates are held fixed, as seen in the figure on the right.

The addition of a node can be undone immediately afterwards by selecting the Undo option of the Edit menu. The “undo” action must be taken before attempting any other actions or switching tools. For example, if a node is added to a plate, and then the point-hand tool is selected, undoing the add is no longer possible. The current version of MacPASCO does not allow deletion of a node or plate once it has been added to the cross section.

The Add-plate Tool

The add-plate tool is represented by the icon shown on the left. When the add-plate tool is selected, the cursor changes into a cross-hair cursor, which looks like a large “plus sign.” The add-plate tool is used to add new plates to a node in an existing cross section.
To add a new plate, move the cursor over a node, press and hold the mouse button, and drag the mouse with the mouse button depressed. As the cursor moves, a new plate appears between the original node and the current cursor position. For convenience, the drawing window message box displays the width and rotation of the new plate. When the mouse button is released, the new plate is added.

The final node of the added plate is always unconnected and not attached to any other existing plates. Thus, two disconnected nodes cannot be joined by drawing a plate between them, as shown below:

draw a plate between these two nodes

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
</table>

To make the cross section shown in figure C. above, but with all the nodes attached, the add-loop tool is required. The add-loop tool is discussed in a subsequent section of this manual.

The addition of a new plate can be undone immediately afterwards by selecting the Undo option of the Edit menu. The "undo" action must be taken before attempting any other actions or switching tools. For example, if new plate is added, and then the point-hand tool is selected, undoing the addition of the plate is no longer possible.

Plates can be deleted from the cross section using the delete-node tool described subsequently in this manual.

The Add-loop Tool

The add-loop tool is represented by the icon image which appears on the left. When the add-loop tool is selected, the cursor changes into a cross-hair cursor, which looks like a large "plus sign." The add-loop tool is used to create a closed section between two nodes on the existing cross section.

To add a loop, move the cursor over a plate and click the mouse button. A closed section composed of two new plates appears, as shown in the figure below:

The closed section is composed of two plates. The other palette tools can be used to create closed sections of three or more plates from this initial cross section, by adding more nodes and manipulating the plates that are created.

The addition of a closed-section can be undone immediately afterwards by selecting the Undo option of the Edit menu. The "undo" action must be taken before attempting any other actions or switching tools. For example, if a loop is added, and then the point-hand tool is selected, undoing the creation of the closed section is no longer possible.

Closed sections can be deleted from the cross section using the delete-node tool discussed in a subsequent section of this manual.
How Closed Sections carry Transverse Loads

Plates in closed sections created with the add-loop tool do not carry transverse loads. The situation is illustrated in the figure below:

The closed section in the leftmost figure was created using the add-loop tool. The user clicked on plate c to create a closed-section formed by plates a and b. The rightmost figure shows a view of the entire panel represented by the MacPASCO drawing on the left. The transverse loads are Ny, which is transverse tension or compression, and Nxy, which is a shear load. The Ny load is entirely carried by plate c. The new plates, a and b, do not carry any Ny load. The Nxy load is distributed according to the stiffness of the shear paths. See references 1 (p. 37-38) and 2 for details.

The Magnifying Glass Tool

The magnifying glass tool is represented by the icon shown on the left. When the magnifying glass tool is selected, the cursor changes into a magnifying glass cursor that looks just like the magnifying glass icon. The magnifying glass tool is used to "zoom" in or out on the current cross section.

Four levels of magnification are available. The initial screen display is at the minimum level of magnification: one cannot zoom-out any further. Each magnification level zooms in by a factor of 2 larger than the previous level.

Zooming in makes the current cross section appear larger on the screen and allows for more precise direct manipulations of the plates. For example, zooming in once magnifies the current cross section so it appears twice as large. Likewise, zooming out allows a smaller view but less control.

- To zoom in, place the cursor in the viewing area displaying the current cross section and click. The view "zooms-in," centered on the cursor position at the time the mouse button was pressed.
- To zoom out, place the cursor in the viewing area displaying the current cross section, hold down the keyboard's option-key and, at the same time, press the mouse button. The view "zooms-out," centered on the cursor position at the time the mouse button was pressed.

Zooming in and out with the magnifying tool has no effect on plate width or rotation. Only the screen display of the plates is changed.
The Delete-node Tool

The delete-node tool is represented by the scissors icon shown at the left. The delete-node tool is used to delete nodes, and consequently plates, from the existing cross section. A plate is deleted when its end node is deleted. When the delete-node tool is selected, the cursor changes into a cross-hair cursor that looks like a large “plus” sign.

- To delete a plate in a chain of plates, do the following: place the intersection of the cross-hair cursor over the end node of the plate and press the mouse button as shown below:

  ![Diagram of plate deletion](image)

  In this case, the delete-node tool acts as the inverse of the add-node tool.

- To delete a plate on the end of a chain of plates, do the following: place the intersection of the cross-hair cursor over the end node of the plate and press the mouse button, as shown below:

  ![Diagram of plate deletion on end](image)

  In this case, the delete-node tool acts as the inverse of the add-plate tool.

- To delete the two plates that form a closed section, do the following: place the intersection of the cross-hair cursor over the shared node between the two plates and press the mouse button, as shown below:

  ![Diagram of closed section deletion](image)

  In this case, the delete-node tool acts as the inverse of the add-loop tool.

The deletion of a node and associated plates can be undone immediately afterwards by selecting the Undo option of the Edit menu. The “undo” action must be taken before attempting any other actions or switching tools. For example, if a node is deleted, and then the point-hand tool is selected, undoing the node deletion is no longer possible.
The File Menu

The File menu, shown at the left, contains all of MacPASCO's commands for opening and closing files. To display the File menu options, move the cursor over the word "File" in the menu bar, then press and hold the mouse button.

Selecting Menu Options

To select a menu option, move the mouse over the word "File" in the menu bar then press and hold the mouse button to display the File menu options. Next, with the mouse button still depressed, move the mouse over the menu option desired. As the mouse moves over each option, the option darkens in the display. Once the desired option is darkened, release the mouse button, and that option is selected.

File Dialog Boxes

When opening or saving a file, MacPASCO displays a dialog box to prompt for the name of the file to be opened or saved. All file dialog boxes follow the same conventions. Sample file dialog boxes for opening files and for saving files appear below:

A file dialog box contains a scrollable list of files and folders as shown above. The list only displays the contents of a single folder or disk at a time. The name of the current folder or disk appears above the scrollable list. To open or save a file in another folder, make that folder the current folder. There are two ways to change the current folder:

1. Double-clicking on a folder displayed in the list makes that folder the new current folder and displays its contents in the scrollable list. Alternatively, clicking on a folder in the list to select it, and then clicking on the Open button also makes the selected folder the new current folder.
2. The current folder name above the list is actually a pop-up menu. Clicking on the current folder name and keeping the mouse button down displays the location of the current folder on the disk. The current folder appears at the top of the list, followed by the folder that contains the current folder, and so on with the disk that contains all the folders at the bottom of the list. Drag the mouse to a folder or disk in this list and release the mouse button. That folder or disk becomes the current folder.

**Switching Disks**

The **Drive** button to the right of the scrolling file list switches disks. Clicking on the **Drive** button cycles through the hard disks and floppy drives connected to the computer. To open or save a file on a floppy disk, insert the disk into the disk drive and click on the drive button. The **Eject** button ejects a floppy disk so that another disk can be inserted. The disk icon above the **Drive** button displays the current disk.

**Cancel**

Clicking on the **Cancel** button cancels the attempt to open or save a file without any files being opened or saved.

**Now**

Select **Now** to begin the specification of a new panel. The **New** menu option creates a new window containing an initial panel cross section, which is a single unstiffened plate with free boundary conditions at both edges, as shown below:

The tool palette and other menu options are used to complete the specification of the panel.

**Open**

Select the **Open** menu option to continue work on a previous panel design that was previously saved as a file. When **Open** is selected, a file dialog box appears so the user can interactively select the file to be opened.
Selecting and Opening a File

The file dialog box contains a scrollable list of files and folders. The list only displays files or folders which might contain a panel design, so only folders and MacPASCO files appear in the list. For example, text files do not appear in the list. To open a file, either double-click twice on the filename displayed in the list, or click once on the filename and then click on the open button.

Finding the File to Open

The list only displays the contents of a single folder at a time. The name of the current folder appears above the scrollable list. If the file to be opened is in another folder, make that folder the current folder so the file appears in the list. Once in the list, the file can be selected and opened. The previous File Dialog Boxes section of this manual describes how to change the current folder to another folder or disk.

Make PASCO Code

The Make PASCO Code option allows the user to generate a text file of PASCO input for the panel displayed in the front-most window. When this option is selected, the following file dialog box appears to prompt for the name of the PASCO input file:

The Make PASCO Code file dialog box is the same as the standard file dialog box discussed in the previous File Dialog Boxes section of this manual. Type the name of the file, then click on the save button and MacPASCO generates the PASCO input and saves it in the file.

The Generated PASCO Input

PASCO's input format is described in reference 1. The PASCO input generated by MacPASCO is an ASCII file which can be used without modification as input to PASCO. The advanced user can modify the generated PASCO input with a text editor to add additional inputs which are not generated by this version of MacPASCO.
Close

Select the Close menu option to stop work on the panel design displayed in the frontmost window and close the window. The same effect is achieved by moving the mouse over the box in the upper left-hand corner of the window and clicking the mouse. If modifications to the panel displayed in the frontmost window have not been saved in a file, the following dialog box appears:

![Save changes to “Untitled-1” before closing?](image)

- The message contains the name of the current frontmost window. The dialog above shows “Untitled-1” as the frontmost window name.

- Click on the Yes button or type the return key from the keyboard to save the modifications in a file.

- Click on the No button to close the frontmost window without saving modifications in a file.

- Click on the Cancel button and the frontmost window is not closed.

Save

The Save menu option saves the panel design displayed in the frontmost window as a file. The first time a save occurs, MacPASCO prompts for the file name with the standard save file dialog box. Just type the name for the file and click on the save button. The previous File Dialog Boxes section of this manual describes how to use the save file dialog box in detail.

Once the panel design has been saved in a file the first time, each subsequent use of the Save menu option saves the panel design in the same file; no additional prompts for the file name appear, and the contents of the file from the previous Save are overwritten. The Save As... and Save a Copy In... options allow saving into different files.

Save As...

The Save As... menu option saves the panel design displayed in the frontmost window as a file. The Save As... option is identical to the Save option, except that the Save As... option always prompts for a file name whereas the Save option only prompts the first time a save occurs. The Save As... option allows the user to save a copy of a panel design in a new file and continue working on the copy.

The File Menu 21
Save a Copy In...

The Save a Copy In... menu option saves the panel design displayed in the frontmost window in a file. A file dialog box appears to prompt for the file name. The previous File Dialog Boxes section of this manual describes in detail how to use the save file dialog box.

Save a Copy In... saves a copy of the original panel design and the user continues working on the original. Save as... saves a copy of the original panel design and the user continues working on the copy. Thus, Save a Copy In... is useful for saving a panel design in various stages of development.

Page Setup...

Select the Page Setup... menu option to change the way pages are printed. For example, pages can be printed horizontally (i.e., with the longest side on the bottom and top of the page) rather than vertically.

This option displays the standard Apple Macintosh page setup dialog box as displayed below:

```
LaserWriter Page Setup


Reduce or Enlarge: %

Orientation: • Portrait ○ Landscape

Printer Effects:
Font Substitution?
Text Smoothing?
Graphics Smoothing?
Faster Bitmap Printing?

OK Cancel Options Help
```

The settings chosen using the Page Setup... options are used by both the Print... and Print One options.

Print One... and Print...

Print... prints the drawing of the panel geometry that appears in the frontmost window. The Print... option displays the standard Apple Macintosh dialog box shown below:

```
LaserWriter "SharonWriter II"

Copies: 1 Pages: • All ○ From: To: Cancel
Cover Page: • No ○ First Page ○ Last Page Help
Paper Source: • Paper Cassette ○ Manual Feed
Print: • Color/Grayscale ○ Black & White

OK Cancel Options Help
```

Usually the panel geometry drawing fits on a single sheet of paper turned horizontally using the Page Setup menu option. If the drawing does not fit on a single sheet of paper, MacPASCO prints multiple sheets of paper such that each sheet contains a section of the panel geometry drawing.
**Print One**

Like Print, Print One prints the drawing of the panel geometry displayed in the frontmost window. However unlike Print..., Print One does not display the Apple dialog box, and only prints one sheet of paper. If the drawing does not fit on a single sheet, only that part of the drawing that fits on one sheet of paper is printed.

**Quit**

The Quit option ends the session with MacPASCO. All the windows are closed. If any panel designs contained in the windows have been modified but not saved, the user is warned with the dialog box described in the Close menu option section of this manual. The dialog box gives the user an opportunity to save panel designs before quitting. Click on the button labeled Yes to save the panel design, click on the No button to avoid saving the panel design. The Cancel button keeps MacPASCO from quitting and allows the MacPASCO session to continue.
The Edit Menu

The Edit menu contains MacPASCO menu commands: **Undo**, **Cut**, **Copy**, **Paste**, **Clear**, and **Show Clipboard**. The current version of MacPASCO does not use the commands **Cut**, **Copy**, **Paste**, or **Clear**. These commands are dimmed in the MacPASCO Edit menu. However, the Apple Macintosh interface guidelines require that these commands appear in the Edit menu for use by Apple desk accessories.

**Undo**

The **Undo** menu option reverses the previous command. For example if you accidentally add a node to the panel geometry, **Undo** removes the node and restores the panel geometry to its previous state. The **Undo** command allows you to change your mind and undo an action.

**Redo**

After undoing an action, the menu option title becomes **Redo xxx**, where **xxx** is the command that was undone. If you choose **Redo xxx**, the undo command is cancelled. For example, if you add a node to a panel geometry and choose **Undo**, the node is removed. If you now choose **Redo**, the node is added to the geometry again, and the menu option title becomes **Undo** in case you change your mind again.

**Can't Undo**

Some actions cannot be undone. If the previous command cannot be undone, the option **Can't Undo xxx** replaces **Undo**. The **xxx** is the name of the command that cannot be undone.

**Show Clipboard**

The **clipboard** is the standard Apple Macintosh name for a buffer which contains graphics and text that has been cut or copied with the **Cut** or **Copy** menu commands. The **Show Clipboard** menu option displays the clipboard window to show the most recently cut or copied text or graphics, and the menu option title becomes **Hide Clipboard**. Since MacPASCO currently does not use **cut** or **copy** this option is not particularly useful at present.
The View Menu

The View Menu contains the following menu options that change the MacPASCO drawing window: the Zoom In and Zoom Out options which magnify the drawing view like the magnifying glass tool from the floating tool palette; the Scale Current View option which changes how screen coordinates correspond to actual coordinates without changing the display; and the Show Plate Numbers option which causes each plate element in the drawing window to display its numeric identifier. Each of these options is discussed in the sections that follow.

Zoom In and Zoom Out

The Zoom In and Zoom Out options magnify the view in the front MacPASCO drawing window. Zooming in makes the current panel cross section appear larger on the screen and allows for more precise direct manipulations of the plates in the model.

Four levels of magnification are available. The initial screen display is at the minimum level of magnification: one cannot zoom out any further. Each magnification level zooms in by a factor of 2. The Zoom In and Zoom Out options are nearly identical to the tool palette's magnifying glass tool.

- **Zoom In** magnifies the view by a factor of 2 and centers the new view in the drawing window.

- **Zoom Out** magnifies the view by a factor of $\frac{1}{2}$ and centers the new view in the drawing window.

- The difference between these menu options and the magnifying glass tool is that the tool uses the cursor position to center the new view and the menu options do not.

Zooming in and out has no effect on the widths and rotations of the plates forming the current cross section; only the screen display is altered.

Scale Current View

The Scale Current View option changes how screen coordinates correspond to actual coordinates. This option is generally used once to scale the current view before drawing the panel cross section.
Select a convenient scale to make drawing and viewing the cross section easier. For example, if the plates forming the panel cross section range in width from 0.1 units to 0.3 units, scaling can be used to specify that one inch on the screen corresponds to 0.1 units. Thus the screen display of a plate 0.3 units wide is 3 inches wide. Alternatively, if the plates in the cross section range in width from 10 units to 30 units in width, scaling can be used to specify that one inch on the screen corresponds with 10 units so that the screen display of a plate 30 units wide is 3 inches.

The following dialog box appears when the Scale Current View is selected:

The plate element on the left shows how the screen image corresponds to the actual distance shown on the right. For the figure above, a plate the size shown in the dialog box is 10 units in width.

The Difference Between Scaling and Zooming

The magnifying glass tool and the two Zoom menu options are used to zoom in or out. They only magnify the screen display, the actual dimensions of the panel cross section do not change. In contrast, scaling changes the dimensions of the panel cross section to accommodate the new scale, but the screen display does not change.

Show Plate Numbers

The Show Plate Numbers menu option displays unique identification numbers with each plate displayed in the front MacPASCO drawing window. When the Show Plate Numbers option is selected, the plate identification numbers appear and the menu option wording changes to Hide Plate Numbers. These plate numbers are used to form the PASCO variable B() in the namelist PANEL.

The plate numbers have two purposes:

1. Plate numbers are useful for understanding PASCO's output since many output quantities are given in terms of plate number.

2. Plate numbers are used when defining linking equations, as described in the section on the Optimization menu options.

The View Menu 26
The Panel Menu

The Panel menu contains MacPASCO options that affect the entire panel. Panel menu options are used to define the total panel length, to define panel loading conditions, to specify the number of stiffeners along the panel width, to specify buckling mode half-wavelengths for which buckling loads are examined, and to view the entire panel cross section (as opposed to the cross section of a single stiffener or repeating substructure shown in MacPASCO's drawing window).

**Apply Panel Loads**

The **Apply Panel Loads** menu option is used to define the total panel length and the panel loading conditions. Selecting this option displays the following dialog box:

In the dialog box above, the entire panel is represented by the quadrilateral figure in the center of the display, with the panel length indicated along the sides of the panel. Possible input values are labeled in the figure.

- To change a value, press the tab key until the value to be changed is highlighted, then type the new value using the keyboard. Alternatively, move the cursor over the desired value with the mouse and click. A bar, |, cursor appears and a new value can be typed. It is usually faster and easier to use the tab key.
• Move the cursor over the OK button and click to close the dialog box.

• Move the cursor over the Cancel button and click to close the dialog and cancel any changes that were specified. Changes to the panel length or panel loads are ignored, and the original values are restored.

Descriptions of each input parameter appear below. Any quoted text is excerpted from reference 1 and page numbers in reference 1 appear parenthetically after the quote.

**Panel Length**

Panel length is the length of the panel. This value corresponds to the PASCO input variable \( EL \) in namelist `PANEL`.

**Mx**

Mx is the “applied bending moment per unit width.” This parameter “should be used when loading is primarily bending and it is desired to have bending forces used in the calculation of the \( \lambda = EL \) buckling mode,” where EL is the panel length. “Bending forces caused by Mx are not influenced by inplane loads” (ref. 1, p. 51). Mx corresponds to the PASCO input variable \( MX(1) \) in namelist `PANEL`.

**Nx**

Nx is the “applied inplane longitudinal load per unit width of panel” (ref. 1, p. 52). Nx corresponds to the PASCO input variable \( Nx(1) \) in namelist `PANEL`, and is positive in compression.

**Nxy**

Nxy is the “applied inplane shear load per unit width of panel” (ref. 1, p. 52). Nxy corresponds to the PASCO input variable \( Nxy(1) \) in namelist in `PANEL`.

**Ny**

Ny is the “applied inplane transverse load per unit width of panel” (ref. 1, p. 52). Ny corresponds to the PASCO input variable \( Ny(1) \) in namelist `PANEL`, and is positive in compression.

**Pressure**

Pressure is the “uniform lateral pressure loading” (ref. 1, p. 52). Pressure corresponds to the PASCO input variable \( Press(1) \) in namelist `PANEL`. 
Eigenvalues

The Eigenvalues menu option is used to specify the eigenvector half-wavelengths, \( \lambda \), for which buckling or frequency eigenvalues are calculated. Selecting the Eigenvalues option displays the following dialog box:

PASCO uses the value of \( \lambda \) to calculate certain eigenvalues by default. If a desired eigenvalue is not calculated by default, the dialog box is used to specify specific wavelengths for which eigenvalues are calculated. Both \( \lambda \) and specific eigenvalue inputs are described in the two sections that follow.

- Clicking on the OK button closes the dialog box.
- Clicking on the Cancel button closes the dialog box without saving any changes made to \( \lambda \) or specific eigenvalues.

\( \lambda \)

Lambda, \( \lambda \), is the smallest half-wavelength for which buckling loads are examined. Lambda is used to derive the PASCO input variable MINLAM in namelist PANEL using the following formula:

\[
\text{minlam} = \frac{\text{panel length}}{\lambda}
\]

Since MINLAM must be an integer, the real number result of \( \frac{\text{panel length}}{\lambda} \) is truncated.

Specific Eigenvalues

The Eigenvalues dialog box is used to enter a number of specific eigenvalues. By default PASCO only calculates certain eigenvalues according to the following logic:

Eigenvalues are calculated for each lambda, \( \lambda \), in the following series:

\[
\frac{\text{panel length}}{1}, \frac{\text{panel length}}{2}, \ldots, \frac{\text{panel length}}{\text{minlam}}
\]
The value of $\frac{\text{panel length}}{\text{minlam}}$, in the previous series, is determined by user input for $\lambda$ using the formula:

$$\text{minlam} = \frac{\text{panel length}}{\lambda}$$

Additional specific eigenvalues not calculated in PASCO by default can be specified in the matrix shown in the Eigenvalues dialog box. Values should be entered row by row from top to bottom in the matrix.

- Each entry should be an integer value. PASCO uses the integer value to calculate an associated $\lambda$ value by the equation: $\lambda = \frac{\text{panel length}}{M}$.

- Zero entries in the matrix will be ignored.

The matrix which appears in the Eigenvalues dialog box represents the PASCO input variable NLAH() in the namelist PANEL.

### Number of Repeating Elements

The substructure displayed in the MacPASCO drawing window is repeated one or more times to form the width of the panel. The **Number of Repeating Elements** menu option is used to specify how many times to repeat the substructure displayed in the MacPASCO drawing window.

When the **Number of Repeating Elements** menu option is selected, the following display prompts for input:

- Type the desired number of repeating elements using the keyboard.

- Click on the **OK** button to close the dialog.

- Click on the **Cancel** button to close the dialog and cancel any changes to the number of repeating elements.

The effect of the **Number of Repeating Elements** menu option can be displayed on screen with the **Show Entire Panel** menu option described in the next section of this manual.

The **Number of Repeating Elements** menu option corresponds to the PASCO inputs NOBAY and ICREP in the namelist PANEL.
Show Entire Panel

The Show Entire Panel menu option displays a new window which shows the cross section of the entire panel. The entire panel's cross section is formed by repeating the stiffener displayed in the MacPASCO drawing window. The number of repetitions is specified by the Number of Repeating Elements menu option.

For example, the figure below shows the Show Entire Panel window for a blade stiffener when the Number of Repeating Elements is three. The blade stiffener display in MacPASCO's drawing window is shown on the left, and the window displayed by the Show Entire Panel menu option appears on the right.

- To close the Show Entire Panel window, move the mouse over the small open box in the upper left-hand corner of the window and click once.
The Laminate Menu

The Laminate Menu options define material property information for the plate elements used to construct the panel cross section displayed in the MacPASCO drawing window. Each plate is a symmetric laminate which consists of layered plies of material. The term laminate means the same as the term wall used in references 1 and 2. The Laminate Menu is used to define the properties of the materials used to form plies, the thickness and angle of the plies themselves, and the ply layups which are used to form each laminate. Finally, the Laminate Menu is used to assign defined laminates to plate elements, thus associating material properties with the geometry.

Since the laminates, plies and material properties are geometry independent, and are often used in different panel cross sections, the Laminate Menu is used to save laminates, plies, and material properties in a separate laminate file. The Laminate Menu can also open existing laminate files. Thus, laminate files can be used to create a database of laminate information for later use, avoiding the redefineion of laminates, plies and material properties.

Define Ply Materials

The Define Ply Materials menu option is used to create a new material, modify an existing material or delete an existing material. To define a material, the user must input the moduli, Poisson’s ratio, coefficients of thermal expansion and other quantities. Once a material has been defined in this way, the material can be used to form the plies that are layered to form laminates.

When the Define Ply Materials menu option is selected, the following dialog box appears:

A list of defined materials appears on the left side of the dialog box. The materials are displayed alphabetically, with uppercase letters preceding lowercase letters.

• To select a material, move the mouse over the material’s name in the alphabetical list and click the mouse button. The material name darkens to indicate selection.

The Laminate Menu 32
To create a new material and add it to the database, click on the button labeled Add.

To modify an existing material, select the material's name in the alphabetical list and click on the button labeled Modify.

To delete an existing material from the database, select the material's name in the alphabetical list and click on the button labeled Delete.

Creating and Modifying Ply Materials

Selecting the add or modify options of the ply material information dialog box described previously results in the following display:

The display shows the current values of ply material attributes, such as Young's modulus and Poisson's ratio. Enter the desired values by selecting a value with the mouse and typing a value from the keyboard. Alternatively, pressing the tab key on the keyboard switches to the next input value.

- The material name must be unique, and can be any text chosen by the user. Attempts to give two different materials the same name cause a warning message to appear.

- E1 represents the Young's modulus in the longitudinal (one) direction.

- E2 represents the Young's modulus in the transverse (two) direction.

- E12 represents the shear modulus for inplane shear (plane of the one-two directions).

- RHO represents the mass density of the material.
• \( \alpha_1 \) represents Poisson's ratio for the material.

• \( \alpha_2 \) represents the longitudinal coefficient of thermal expansion.

• \( \alpha_3 \) represents the transverse coefficient of thermal expansion.

Material Failure Criteria and Allowables

The current material failure criterion is displayed using the pop-up menu labeled Criterion in the ply material display. Moving the cursor over Criterion and pressing the mouse button "pops-up" a menu of three possible failure criteria: Strain, Stress, and Tsai-Wu as shown below:

Move the mouse up or down (with the mouse button depressed) in the pop-up menu to select a failure criterion. The selected criterion darkens. When the mouse button is released, the selected criterion becomes the failure criterion for the material.

The allowables for the failure criterion appear beneath the criterion in the ply material display. The allowables for each criterion are given by the following table:

<table>
<thead>
<tr>
<th>Stress</th>
<th>Strain</th>
<th>Tsai-Wu</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \sigma_1 )</td>
<td>( (\varepsilon_1 - \sigma_1 \Delta T) )</td>
<td>( \sigma_1 )</td>
</tr>
<tr>
<td>( \sigma_2 )</td>
<td>( (\varepsilon_2 - \sigma_2 \Delta T) )</td>
<td>( \sigma_2 )</td>
</tr>
<tr>
<td>( \tau_{12} )</td>
<td>( \gamma_{12} )</td>
<td>( F_{12} )</td>
</tr>
</tbody>
</table>

The abbreviations long., trans., comp. and ten. mean longitudinal, transverse, compression, and tension, respectively. The allowable stresses and strains are entered as positive for compression and negative for tension. \( F_{12} \) is a quantity in the Tsai-Wu material strength criterion (see eq. (49), ref. 1).

Define Plies

The Define Plies menu option is used to create a new ply, modify an existing ply or delete an existing ply. To define a ply, the user must input the ply thickness, ply angle, and select the material which forms the ply. Defined plies are used to form laminates.
When the Define Plies menu option is selected, the following dialog box appears:

A list of defined plies appears on the left side of the dialog box. The plies are displayed alphabetically.

- To select a ply, move the cursor over the ply's name in the alphabetical list and click the mouse button. The ply name darkens to indicate selection.

- To create a new ply and add it to the database, click on the button labeled Add.

- To modify an existing ply, select the ply's name in the alphabetical list and click on the button labeled Modify.

- To delete an existing ply from the database, select the ply's name in the alphabetical list and click on the button labeled Delete.

### Creating and Modifying Plies

Selecting the add or modify options of the ply information dialog box described previously results in the following display:
The display shows the current values of ply attributes, such as ply thickness and ply angle. Enter the desired values by selecting a value with the cursor and by typing a value from the keyboard. Alternatively, pressing the tab key on the keyboard switches to the next input value.

- The ply name must be unique, and can be any text chosen by the user. Attempts to give two different plies the same name causes a warning message to appear.

- Ply angles are given in degrees by a positive number between 0 and 360. Although the ply angle is defined as positive, the ply angle can be made negative within a stacking sequence for a laminate when the laminate is defined using the Define Laminates menu option, discussed in a subsequent section of this manual.

- Ply thickness must be a positive number.

- Ply angles and thicknesses can be design variables during optimization. The check boxes labeled design variable indicate that the ply angle or thickness respectively are design variables. When a cross, X, appears in the check box, the ply angle or thickness is a design variable during optimization. When no cross appears, the ply angle or thickness is not a design variable. If the ply angle or thickness is not a design variable, clicking on the check box makes the ply angle or thickness a design variable. If the ply angle or thickness is a design variable, clicking on the check box makes the ply angle or thickness not be a design variable. The upper and lower bound fields are disabled when the ply angle or thickness is not a design variable.

- A list in the lower-left of the display lists the currently defined materials by name. One of these materials must be selected for the ply. The material is selected by clicking on the material name in the list. The selected material is darkened.

- The value of temperature is the change in temperature for the ply.

- In the current version of MacPASCO, only values for a single loadcase can be entered. Hence, the loadcase number display is dimmed and cannot be changed.

Define Laminates

The Define Laminates menu option is used to create a new laminate layup, to modify an existing laminate layup or to delete an existing laminate layup. To define a laminate, a layup is created from previously defined plies. The layup must be balanced and symmetric. Once completed, laminates can be assigned to the plate elements that make up the structural geometry.
When the Define Laminates menu option is selected, the following laminate information dialog box appears:

A list of previously defined laminates appears on the left side of the dialog box. The laminates are displayed alphabetically.

- To select a laminate, move the cursor over the laminate's name in the alphabetical list and click the mouse button. The laminate name darkens to indicate selection.

- To create a new laminate and add it to the database, click on the button labeled Add.

- To modify an existing laminate, select the laminate's name in the alphabetical list and click on the button labeled Modify.

- To delete an existing laminate from the database, select the laminate's name in the alphabetical list and click on the button labeled Delete.

Creating and Modifying Laminates

Selecting the add or modify options of the laminate information dialog box described previously results in the following display:
The laminate's name and total thickness are listed at the upper left and right corners of the display. The display also lists previously defined plies on the right under the heading "Possible Plies." The current layup for the laminate is displayed on the left in the list labeled "Stacking Sequence." Since the laminate must be symmetric, only half of the laminate is defined up to the midplane of symmetry. The remainder of the laminate is automatically defined as a mirror image. The layup display shows a stack of plies; the ply at the outer surface appears at the top of the stack, followed by the second outermost ply, and the stack progresses inwards so that the ply at the bottom of the stack is at the midplane of symmetry.

Laminate layup sequences are created by clicking to select plies from the list on the right and then clicking on the copy button to add the plies to the layup. The laminate layup is rearranged by clicking on a ply in the stacking sequence and dragging the ply to a new position; the other plies shift to accommodate the change.

- Selecting a ply in the stacking sequence and clicking on the button labeled Change Sign inverts the sign of the selected ply angle. Since the laminate layup must be balanced, the sum of ply angles in the layup which are non-zero and non-ninety must be zero.

- Selecting a ply in the stacking sequence and clicking on the button labeled "delete" removes the selected ply from the stacking sequence.

- The thickness displayed by the template is total thickness of the laminate. Since only half the laminate is defined, the total laminate thickness is twice the sum of the thicknesses of the plies shown in the stacking sequence. Recall that laminates which physically have an odd number of plies are modeled with an even number of plies by splitting the center ply at the midplane into two plies, each with half the thickness of the original center ply.

**Assign Laminates to Plates**

The **Assign Laminates to Plates** menu option is used to associate defined laminates with the plate elements that form the geometry. The definition of laminates is discussed in the previous section. To associate a laminate with one or more plate elements, do the following:

1. Choose the point-hand tool or the grab-hand tool and then point and click to select a plate element. The selected plate darkens. Multiple plates can be selected by pointing and clicking while the shift key down on the keyboard (see the point-hand tool or grab-hand tool discussions for details).

2. Choose the **Assign Laminates to Plates** menu option.
3. The following display appears on the screen which lists previously defined laminates:

![Laminates Display]

4. Select a laminate from the list by pointing and clicking on the laminate name, and then click on the button labeled “OK.” This process associates the chosen laminate with the selected plate elements.

**Open Laminate File**

The **Open Laminate File** menu option is used to open database files containing material, ply and laminate information. Such database files are created with the **Save Laminate File** menu option discussed in the next section of this manual. The database files are used to save defined materials, plies, and laminates for a given panel design. The database files can be shared so that the same definitions can be used for other panel designs. This process avoids repeated definitions of the same materials, plies and laminates.

When the **Open Laminate File** menu option is selected, the following dialog box appears:

![Dialog Box]

This dialog box is the standard Apple file dialog box which prompts for the name of the file to be opened. The use of the file dialog box is discussed in detail in the File Dialog Boxes section of the File Menu chapter of this manual.

Existing laminate files and folders from the current folder are displayed. The name of the current folder is displayed above the list. Once in the correct folder, point and click to select the desired file name in the list, then click on the “Open” button. Alternatively, double-clicking on the file name also opens the selected file.

When a laminate database file is opened, the materials, plies, and laminates in the file are added to any materials, plies, and laminates that are defined in the current panel model.
Warning Messages

When opening a database file, if the database file contains a material with the same name as an existing material, the following dialog box appears. An analogous warning appears when two ply names or two laminate names conflict.

```
Material 1 is already defined. Do you wish to replace it?

OK
Cancel
```

- Click on the button labeled "OK" to replace the existing material with the new material from the database file.

- Click on the button labeled "Cancel" to retain the existing material without making a replacement.

Save Laminate File

The Save Laminate File menu option is used to save the materials, plies and laminates in an independent database file. This process is used to share the same definitions for other panel designs and avoid repeated definitions of the same materials, plies and laminates.

When the Save Laminate File menu option is selected, the following dialog box appears:

```
Save this document as: Laminate file

Save Cancel
```

This dialog box is the standard Apple file dialog box which prompts for the name of the file to be saved. The files and folders in the current folder are displayed, and the name of the current folder is displayed above the list. The names of files are dimmed. The use of the save file dialog box is discussed in detail in the File Dialog Boxes section of the File Menu chapter of this manual.

Once in the correct folder, type the desired name for the new laminates file in the space provided and click on the “Save” button. The file is saved on the disk.
The Optimization Menu

The Optimization Menu options enable structural optimization to be performed and are used to construct linking equations often required during optimization. The optimizer must satisfy these equations when choosing design variable values. Design variables are not specified with the Optimization Menu options, but are specified as part of the information associated with a plate element or ply.

Sizing Cycles

The Sizing Cycles menu option is used to specify the number of sizing cycles during optimization which is the PASCO input, MAXJJ. When this menu option is selected, the following dialog box appears:

![Sizing Cycles Dialog Box]

- Type the number of sizing cycles desired and click the button labeled "OK" to change the number of sizing cycles.

- When the number of sizing cycles is zero, the MacPASCO generated input instructs PASCO to perform no optimizations and simply analyze the initial panel design. This instruction is the default setting.

Linking Equations

The Linking Equations menu option is used to create design-variable-linking equations. Design-variable-linking equations must contain two types of variables: dependent and independent variables. The values of the dependent variables are determined by solving the linking equations using the values of the independent variables. In general, several of the linking equation independent variables are also optimization design variables. Design-variable-linking equations restrict possible values for design variables because during the optimization process, design variable values are limited to those values which satisfy these equations.
When the linking equations menu option is selected, the MacPASCO linking equation editor is displayed on the screen. The editor is used to create new linking equations and to modify existing equations. The linking equation editor is shown below:

The use of the linking equation editor is described in detail in subsequent sections of the manual, but an overview is given below:

1. The equation being edited is displayed in the lower scrollable view: it is blank for new equations.
2. A plate is selected by pointing to the cross section displayed in the drawing window, using either the point-hand tool or the grab-hand tool. The selected plate element’s width can be made a linking equation variable. The “Selected Plate #” field displays the number associated with the selected plate element.
3. The scrollable view labeled “Plies for Linking Equations” shows a list of defined plies. Plies from this list are selected by pointing and clicking. The selected ply’s angle or thickness can then be included in a linking equation.
4. Linking equations are numbered, and the number of the equation currently being edited is displayed to the right of the word “Equation.”
5. The box labeled “Add Plate Width” is a pop-up menu which is used to add variables to an equation.
6. The box labeled “Next” is a pop-up menu which is used to select an existing equation to edit or to create a new equation.
7. The box labeled “Coefficient” displays the coefficients of linking equation variables.
8. The check-box labeled “Is Dependent Variable” is used to designate variables as dependent variables. Dependent variables are discussed in a subsequent section of this manual.
9. The button labeled “Show All Equations” displays a list of all defined linking equations and allows the equations to be printed. The printed list of the equations can be a useful summary and an aid when creating many linking equations.
**Adding Variables to Linking Equations**

A variable is added to a linking equation in two steps:

1. Select the variable.
   - Plate elements are selected in the drawing window by pointing and clicking using the point-hand tool or grab-hand tool.
   - Plies are selected from the ply list on the upper right-hand-side of the linking equation editor display. Move the cursor over the desired ply name and press the mouse button.

2. Add the variable to the equation using the pop-up menu to the left and immediately above the display of the current linking equation. When the mouse button is pressed with the cursor over the variables pop-up menu, the following options are displayed:

   ![Menu Options]

   Menu options are dimmed when they cannot be selected. For example, a ply thickness cannot be added if no ply is selected.

**Add Plate Width**

Choose the **Add Plate Width** option to add the selected plate element's width to the linking equation, as shown below:

![Linking Equations]

The two upper windows show the drawing window (upper left) and the linking equation editor window (upper right). The editor window shows the “add plate width” option being selected, before the mouse button is released. The lower right window shows the editor window when the mouse button is released and the selected plate element width is added to the linking equation.
Add Ply Thickness

Choose the Add Ply Thickness option to add the selected ply's thickness to the linking equation. The ply is selected from the list of ply names in the linking equation editor display by pointing and clicking.

For example, the window below shows the linking equation editor window after adding a ply thickness:

- The ply named Ply 1 was selected from the ply list and added to the linking equation with the Add Ply Thickness pop-up menu option.

- The linking equation variable name is Ply 1 t, which is the ply name followed by the letter “t” to indicate ply thickness.

Add Ply Angle

Choose the Add Ply Angle option to add the selected ply's orientation angle to the linking equation. The ply is selected from the list of ply names in the linking equation editor display by pointing and clicking.

For example, the window below shows the linking equation editor window after adding a ply angle:

- The ply named Ply 2 was selected from the ply list and added to the linking equation with the Add Ply Angle pop-up menu option.

- The linking equation variable name is Ply 2 >, which is the ply name followed by the character “>” to indicate ply angle.
Add Right Hand Side

Choose the **Add Right Hand Side** option to add a right hand side (i.e., the right hand side of the equality) to the linking equation. The right hand side's initial value comes from the entry labeled "Coefficient." For example, the window below shows the linking equation editor window when the **Add Right Hand Side** option is selected:

![Linking Equation Editor Window](image)

When the mouse button is released, a right-hand-side value of 0 is added to the equation, as shown below:

![Linking Equation Editor Window](image)

**Modifying Variable Coefficients or the Right Hand Side**

Coefficient values are specified in the entry labeled "Coefficient" in the linking equation editor.

To change a variable coefficient do the following:

1. Select the variable by pointing to the variable in the linking equation and clicking the mouse button. The variable darkens in the equation when it is selected as shown below:

![Linking Equation Editor Window](image)
2. Type the desired value for the coefficient using the keyboard. The entry labeled "Coefficient" displays the value typed. In addition, the linking equation display is automatically updated with the new coefficient as it is typed. For example in the equation below, a coefficient of -2 has been entered.

\[ \text{Value on the right of the equal symbol (\(=\)) in a linking equation is modified in the same way that variable coefficients are modified:} \]

1. Select the current right-hand-side value by pointing and clicking as shown below:

2. Type the desired value using the keyboard. The display updates automatically during typing.

**Dependent and Independent Variables**

As stated previously, linking equations must contain two types of variables: dependent and independent variables. The values of the dependent variables are determined by solving the linking equations. The values of the independent variables are considered as constants when determining dependent variable values. It is often the case that some of the linking equation independent variables are also optimization design variables. During optimization, the optimization algorithm supplies new values for the design variables. In turn, these new design variable values are used in the linking equations to determine new values for the dependent variables.

For example, the figure below shows a hat stiffener with the plate elements numbered:
The goal is to force the widths of plates 4 and 6 to be the same and thus keep the widths of the sides of the hat stiffener equal during optimization. This goal can be accomplished by creating the equation:

\[
\text{width plate 6} = \text{width plate 4}
\]

In MacPASCO, the equivalent equation,

\[
\text{width plate 6} - \text{width plate 4} = 0
\]

is created.

In this example, the width of plate 4 is chosen as a dependent variable, and the width of plate 6 is chosen as an independent variable and as a design variable. Hence, as the optimizer varies the width of plate 6, the linking equation insures an equal width for plate 4.

Designating Dependent Variables

To make a variable a dependent variable, do the following:

1. Select the variable by pointing to the variable in the displayed equation and clicking the mouse button.

2. Click on the check box labeled “Is Dependent Variable.” If a cross, X, appears in the check box, the variable is a dependent variable, otherwise it is considered to be an independent variable.

Deleting Variables from a Linking Equation

Variables are deleted from a linking equation with the same pop-up menu used to add variables. To delete a variable or right hand side from a linking equation do the following:

1. Select the variable to be deleted by pointing and clicking.

2. Point to the pop-up menu in the upper left of the equation display, then press and hold the mouse button. The following menu options appear:

```
Add Plate Width
Add Ply Thickness
Add Ply Angle
Add Right Hand Size
Delete Variable
```

Unavailable menu options are dimmed.

3. Select Delete Variable from the listed menu options and the variable is deleted from the linking equation.
Changing Linking Equations

MacPASCO maintains a list of the defined linking equations. Initially the linking equation editor displays the first linking equation in the list. The pop-up menu under the words “Plies for Linking Equations” is used to traverse the linking equation list as follows:

- Select Next to display the next linking equation. Each linking equation is numbered, and the number appears after the label “Equation:” in the display.

- Select Previous to display the previous linking equation.

- Selecting Next when the last linking equation is displayed creates a new linking equation.

Show All Equations

The Show All Equations button in the linking equation editor opens the equation summary, a text window which lists all defined linking equations. The summary is used as an aid when many linking equations are created. The equation summary is not editable, but can be printed for documentation or further reference. An example equation summary window is shown below:

The summary window contains a scrollable view which lists the linking equations.

- Select the Print button to print the list of linking equations.

- Select the OK button to close the equation summary window and return to the linking equation editor.
The first example of modeling with MacPASCO is a laminated, unstiffened plate loaded in longitudinal compression as shown below. This example is the same as Example 1 in reference 1.

The plate is 8 inches wide and 30 inches long and is subjected to a 1000 lb/inch compressive load. All four plate edges are simply supported. The plate is a balanced, symmetric laminate as shown above. Ply thicknesses, T, and orientations, θ, are given in the columns to the right of the laminate sketch. The dotted line represents the midplane of symmetry.
Panel Geometry Modeling

The typical MacPASCO user begins by modeling the panel geometry. The initial MacPASCO screen display is shown below:

![Image of MacPASCO screen display]

The initial MacPASCO panel is a single plate, so only the plate dimensions need to be adjusted to model the panel geometry for this example. There are two ways to adjust the plate's width: use the plate information display or use the grab-hand tool to adjust the plate to the correct width. Both methods are described.

Use of the Plate Information Display

The point-hand tool is selected by clicking on the point-hand icon in the tool palette window. The tool palette icon darkens to indicate selection, and the cursor's shape changes to a point-hand icon. The cursor is then moved over the plate in the drawing window as shown below:

![Image of plate information display and cursor on plate]

Example 1: Laminated Unstiffened Plate 50
Double-clicking the mouse when the cursor is over the plate displays the plate information box shown below:

![Plate Information Display](image)

The plate information display shows the plate's width and rotation. The number 8 is entered from the keyboard as the new plate width, which results in the display below:

![Plate Information Display (Width 8)](image)

After clicking on the button labeled "OK," the plate width changes to its new width, as shown below. The plate is darkened because it is selected, and the message box shows the selected plate's width and rotation.

![Selected Plate](image)

Example 1: Laminated Unstiffened Plate 51
Use of the Grab-hand Tool

The grab-hand tool is selected by clicking on the grab-hand icon in the tool palette window. The tool palette icon darkens to indicate selection, and the cursor's shape changes to a grab-hand icon. The cursor is then moved over one of the end nodes of the plate in the drawing window as shown below:

![Grab-hand tool selection](image)

The grab-hand cursor is positioned so that the cross-hairs are over the plate node. Move the node and the plate changes dimensions to follow the movement of the mouse as shown below:

![Grab-hand tool movement](image)

The message box displays the width and rotation of the plate as it changes dimensions so the plate can be made the correct width. Once the plate has the correct width and rotation, the mouse button can be released. Sometimes, it is not possible to adjust the plate to the correct width with the grab-hand tool, in which case the plate information display must be used.

Panel Length and Loads

The panel length is defined using the Apply Panel Loads option of the Panel menu. Moving the cursor over the Panel menu at the top of the screen and then pressing the mouse button displays the Panel menu options, shown below:

![Panel menu options](image)

Example 1: Laminated Unstiffened Plate 58
The Apply Panel Loads option is selected by dragging the cursor until the option darkens and then by releasing the mouse button. This action displays the current panel length and load conditions. The number 30 is entered as the panel length and 1000 is also entered as the $N_x$ load, as shown below:

![Panel Loads Schematic](image)

**Boundary Conditions**

Only boundary conditions along the lateral edges of the panel can be specified. PASCO assumes sinusoidal behavior in the longitudinal direction which results in simply supported end conditions for the longitudinal edges.

The boundary conditions on the lateral edges of the panel are initially free in MacPASCO, as indicated by the notation $f_1$ at the start and final nodes. The start and final nodes represent the left and right edges of the panel respectively. Boundary conditions are defined using the node information display. The point-hand tool is selected and the cursor is positioned over the start or final node, as shown below:

![Boundary Conditions Schematic](image)

*Example 1: Laminated Unstiffened Plate 59*
Clicking the mouse button displays the node information on the screen as shown below:

Positioning the cursor over the current boundary condition and pressing the mouse button displays a choice of boundary conditions. The choice of boundary conditions remains displayed until the mouse button is released. For this example, a simple support boundary condition is required which corresponds to MacPASCO's SS2 boundary condition. A table in the boundary condition section of this manual describes the notation for each boundary condition in detail. The SS2 boundary condition is selected from the choice of boundary conditions by moving the cursor until the desired boundary condition darkens, as shown below, and then releasing the mouse button:

Example 1: Laminated Unstiffened Plate 54
The figure below shows the screen display after both boundary conditions have been defined as a simple support (SS2):

![Screen Display](image)

**Laminates**

The panel geometry, loading conditions, and edge conditions have been described, but the laminates used in the panel have not been modeled and associated with the geometry. A laminate consists of layered plies of material, where each ply is of a specified material, thickness and orientation. There are three steps to modeling a laminate in MacPASCO. First, the properties for the ply material are defined. Next, the material, thickness, and orientation for individual plies are defined. Last, a stacking sequence is defined for each laminate. The stacking sequence defines how the plies are layered to form a laminate. Once a laminate is modeled, it is associated with the appropriate parts of the panel geometry.

**Material Definition**

In this example, all plies are of the same material. This material is defined using the Define Ply Materials option of the Laminates menu. When the Define Ply Materials option is selected, the defined materials list appears as shown below:
Material properties for aluminum are included by default. Clicking on the button labeled “Add” displays an input template for material properties so a new material can be defined. The figure below shows the material property template after the appropriate property information was entered for this example.

For this example, a strain failure criterion is selected. A click on the button labeled “Done” dismisses the template and displays the defined material list, as shown below:

The newly defined material appears in the list.

A click on the button labeled “Done” dismisses the materials list display.

Example 1: Laminated Unstiffened Plate 56
Ply Definition

The laminate used for this example is repeated below:

This laminate can be constructed by defining three kinds of plies: a 0.02-inch-thick 45° ply, a 0.02-inch-thick 90° ply, and a 0.01-inch-thick 0° ply. The 0° ply is only 0.01 inches thick because laminates are only defined to the midplane of symmetry. The -45° ply is created from a +45° ply when the plies are layered to form the complete laminate.

Each ply is defined using the Define Plies option of the Laminates menu. When the Define Plies option is selected, the defined ply list appears as shown below:

Initially, the list is empty.

Clicking on the button labeled “Add” displays an input template for ply information so a new ply can be defined. The figure below shows the template after appropriate property information was entered for the 45° ply.

The ply thickness and angle have been selected as design variables for optimization as indicated by the cross (X) in the design variable check box in the display. A click on the button labeled “Done” returns to the defined plies list, and the new ply name appears in the ply list.
The information for the remaining plies is input the same way: clicking on the “Add” button to display the ply information template, entering the information, and then clicking on the template’s “Done” button. The figures below show the input templates with property information for the 90° and 0° plies.

![Ply Information Template](image)

For this example the ply thicknesses have been chosen as design variables. Also, the ply angle is a design variable for the 90° ply, but not for the 0° ply. The defined ply list after all three plies have been created is shown below:

![Ply Information](image)

### Laminate Definition

The panel in this example only requires a single laminate, which is defined using the Define Laminates option of the Laminates menu. When the Define Laminates option is selected, the defined laminate list appears, as shown below:

![Laminate Information](image)
Initially the list is empty; clicking on the button labeled “Add” displays an input template used to define a new laminate. The figure below shows the initial input template.

The list of defined plies appears on the right. The sequence of figures that follow show the creation of the laminate by selecting defined plies and adding them to the stacking sequence.

The 45° ply is selected from the ply list and copied into the laminate layup using the copy button.

After copying, the 45° ply appears in the laminate layup. At this point, the laminate consists of two 45° plies (recall that the stacking sequence only shows the layup to the midplane of symmetry).

Example 1: Laminated Unstiffened Plate 59
A second 45° ply, a 90° ply, and a 0° ply are added to the stacking sequence resulting in the display shown below.

The laminate is almost complete; all that remains to be done is changing the second 45° ply into a -45° ply.

The second 45° ply is selected by clicking on it. The ply angle is changed to a -45° ply by clicking on the Change Sign button.

The display for the completed laminate is shown below.

Example 1: Laminated Unstiffened Plate 60
Once a laminate has been defined, click on the "DONE" button to dismiss the input template and return to the defined laminate list, shown below:

![Laminate Information](image)

The newly defined laminate's name now appears in the list. The laminate list display is dismissed by clicking on the "Done" button.

Once the laminate is defined, the laminate must be associated with the panel geometry. In this example, the geometry is a single flat plate. The plate is selected using the point-hand tool, and then the Assign Laminates to Plates option of the Laminates menu is selected. The resulting display is shown below:

![Plate Information](image)

The drawing window appears in the background, and a smaller window appears listing the defined laminates appears in the foreground. In this example, the list contains only one laminate defined previously. The laminate is selected by clicking on the laminate name. Clicking on the "OK" button associates the selected laminate with the selected plate(s) and dismisses the laminate list window.

**Buckling Mode Wavelength**

PASCO examines a series of buckling modes. The modes considered is determined by \( \lambda \), the length of the minimum buckling mode half-wavelength. For example, \( \lambda = \text{panel length} \) means a buckling mode with a half-wavelength equal to the panel length is examined. When \( \lambda = \frac{\text{panel length}}{2} \), both the panel buckling mode with a half-wavelength of half the panel length and the buckling mode with a half-wavelength equal to the panel length are examined. Of all the buckling modes examined, PASCO outputs the critical buckling mode (the mode with the lowest buckling load). The user controls which buckling modes are to be examined by specifying the smallest buckling mode half-wavelength \( \lambda \) to be examined.

*Example 1: Laminated Unstiffened Plate 61*
The value for \( \lambda \) is specified using the Eigenvalues option of the Panel menu. When the Eigenvalues menu option is selected, the following display appears:

For this example, the panel length is 30 inches. A value of \( \lambda = 1 \) is specified, which instructs PASCO to examine the buckling modes with the following half-wavelengths:

\[
\frac{30}{1}, \frac{30}{29}, \frac{30}{28}, \ldots, \text{and} \frac{30}{1} \text{ (the panel length)}
\]

Of all these buckling modes, PASCO only outputs the critical modes with the lowest buckling load.

**Sizing Cycles**

The Sizing Cycles option of the Optimization menu is used to indicate the number of sizing cycles during optimization. When the Sizing Cycles option is selected, the following dialog box prompts for the number of sizing cycles:

Initially, zero sizing cycles are specified, which results in analysis only without optimization. For this example, a single sizing cycle is specified by typing a one in the dialog box, as shown below:

Once the number of sizing cycles is entered, the dialog box is dismissed by clicking on the button labeled, "OK."

Example 1: Laminated Unstiffened Plate 62
Generate the PASCO Input

At this point, the panel itself is modeled, and the analysis and optimization conditions are specified. All that remains to be done is to generate a text file containing the appropriate PASCO input by selecting the Make PASCO Code option of the File menu as shown below:

When the Make PASCO Code option is selected, a file dialog box appears to prompt for the name of the file to be generated.

The PASCO input file generated by MacPASCO is shown on the following page. This text file is input to PASCO to analyze and optimize the example panel.

Example 1: Laminated Unstiffened Plate 63
Example 1: Laminated Unstiffened Plate 64
Example 2: Blade-Stiffened Panel

The second example of modeling with MacPASCO is a laminated, blade-stiffened panel loaded in longitudinal compression as shown below (not to scale). This example is similar to Example 2 in reference 1.

\[ N_x = 3000 \]
The panel is 30 inches long, has sixteen blade stiffeners, and is subjected to a 3000 lb/inch compressive load with symmetry boundary conditions on the lateral edges of the panel. All sixteen stiffeners are identical. Three distinct laminates are used: a skin laminate, a blade laminate, and an attachment flange laminate. Ply thicknesses and orientations for each laminate are given in the columns to the right of the sketches above. The midplane of symmetry for each laminate is denoted with a dotted line. All plies are made of the same material. Design variables for optimization are stiffener spacing and ply thicknesses.

Modeling this blade stiffened panel illustrates several MacPASCO features that were not shown previously while modeling an unstiffened plate (example 1). MacPASCO modeling tools are required to model the blade stiffeners. In addition, stiffener spacing and ply thicknesses are design variables during panel optimization, and linking equations are used to insure uniform stiffener sizing. The discussion that follows concentrates on MacPASCO features that were not discussed in the unstiffened plate example.

Panel Geometry Modeling

The user's first task when modeling a stiffened panel is to identify a substructure that can be repeated to form the panel. In the case of the blade stiffened panel, a single blade stiffener is chosen as the repeating substructure which repeats sixteen times across the width of the panel. If the blade stiffeners were more irregular, one might be required to define each stiffener individually.

The blade stiffener is modeled with plate elements, as shown below:

Blade Stiffener

Plate Element Model

The blade stiffener appears on the left, and a plate element model appears on the right. The blade stiffener is modeled by five plate elements, which are numbered above. The small squares represent the junction or attachment points (nodes) of plate elements. MacPASCO's modeling tools are used to create the plate element model in the figure above.

Example 2: Blade-Stiffened Panel 66
Scaling the Display

The first consideration is the *scale* of the screen display. The *scale* determines how the screen coordinates correspond to actual coordinates, just as the scale on a road map indicates how inches on the map correspond to miles on the actual road. The scale is chosen to make drawing and manipulating the blade stiffener as convenient as possible. The *Scale Current View* option of the View menu is used to scale the screen display. When the *Scale Current View* option is selected, the following dialog box appears:

The scale dialog box shows the screen display of a plate element under the current scale. The blade stiffener is only 2 inches wide. Under the initial scale, the screen display of the blade would be inconveniently small, as shown below:

\[
\begin{array}{c}
= 10.0
\end{array}
\]

The plate element of the scale dialog box looks like a reasonable display of half the blade stiffener width, as shown below:

\[
\begin{array}{c}
= 1.0
\end{array}
\]
From the scale dialog box, the keyboard is used to change the scale as shown below. Clicking on the button labeled "OK" dismisses the scale dialog box.

![Scale Dialog Box](image)

**Adding Nodes**

The add-node tool is selected to add nodes to the initial screen display. Then the cursor is moved over the plate element in the drawing window. Clicking on the plate adds a node, which will serve as an attachment point. Dragging the cursor moves the new node as the node is added. Holding the option key on the keyboard down while adding a node allows the new node to be dragged without changing the plate rotations, as shown below:

![Adding Nodes](image)

The cursor becomes a plus (+) when the add-node tool is selected. Adding a node divides the original plate element into two new plate elements. The message box shows the width and rotation of the plate element represented by a dashed line in the screen display.

Two additional nodes are added in the same way; the result is shown below:

![Additional Nodes](image)
Adding the Blade

The add-plate tool is used to complete modeling of the blade stiffener. The add-plate tool is selected from the tool palette, and the cursor is moved over the center node in the screen display, as shown below:

Pressing the mouse button adds a new plate element which is dragged into the correct position, as shown below. The message box displays the plate width and rotation its dimensions change.

In the two right-hand figures above, the drawing window scrolls as the mouse is dragged downward. In the rightmost figure above, the window has scrolled down so far that the top of the stiffener is no longer visible.

After completing the blade, the user adjusts and resizes the window so that the entire stiffener is visible, as shown below:

This completes the basic geometry of the blade stiffener.
Repeating Elements

The Number of Repeating Elements option of the Panel menu is used to specify that the blade stiffener is repeated sixteen times across the width of the panel. Selecting the Number of Repeating Elements option prompts for the number of repeating elements. The prompting dialog box is shown below after sixteen repeating elements were specified.

Panel Length and Loads

The panel loads and length are specified using the Apply Panel Loads option of the Panel menu. In this case, the panel length is specified as 30 inches and 3000 lb/inch is also entered as the $N_z$ load as shown below.
**Boundary Conditions**

Boundary conditions on the lateral edges of the panel are specified using the node information dialog box, which is displayed by clicking on a node. The node information box displays whether a node is the start node, representing the left edge of the panel, or the final node, representing the right edge of the panel. In this case, symmetry boundary conditions are chosen. The figure below shows the selection of a symmetry boundary condition on the final node, representing the right edge of the panel.

![Node Information Dialog Box](image)

**Laminates**

Recall that three distinct laminates are used in the blade stiffener: the skin laminate, the blade laminate, and an attachment flange laminate. Each laminate consists of layered plies of the same composite material, where each ply is of a specified thickness and orientation. There are three steps to model laminates in MacPASCO. First the properties for the ply materials are defined, next individual plies are defined, and lastly the stacking sequences for individual laminates are defined.

---

*Example 2: Blade-Stiffened Panel 71*
Material Definition

As discussed in the *Material Definition* section of example 1, ply materials are defined using the *Define Ply Materials* option of the Laminates menu. The figure below shows the material property template for the composite material:

![Material Property Template](image)

**Material Failure Criterion and Allowables**

**Criterion:** Strain

- $(c_1 - c_1\Delta T)$ compression: 0.004
- $(c_1 - c_1\Delta T)$ tension: -0.004
- $(c_2 - c_2\Delta T)$ compression: 0.004
- $(c_2 - c_2\Delta T)$ tension: -0.004
- $\gamma_{12}$ shear: 0.01
- $P_{12}$ Jnmar: 0.000000000000

Ply Definition

The laminates used in this example are shown below:
These laminates can be constructed by layering four kinds of plies: a 0.004-inch-thick 45° ply, a 0.01-inch-thick 0° ply, a 0.004-inch-thick 0° ply, and a 0.003-inch-thick 0° ply.

In MacPASCO, plies are defined using the Define P1ies option of the Laminates menu. Since the details of ply definition were discussed previously in the Ply Definition section of example 1, the following figures only show the ply information displays:
The ply thicknesses have been selected as design variables for optimization. Since only one 45° ply (Blade45) has been defined, the same ply is used in all three laminates (blade, skin and attachment flange). It may be that the optimal design uses a different thickness of the 45° ply in the blade than in the skin and attachment flange. To permit this possibility, an additional 45° ply is defined as shown below:

The Blade45 ply is used (see the next section) in the stacking sequence of the laminate for the blade, and the Skin45 ply defined above is used (see the next section) in the stacking sequence of the laminates for the skin and attachment flange. Thus during optimization, the thickness of the Blade45 ply in the blade laminate is independent of the thickness of the Skin45 ply in the skin and attachment flange.

**Laminates Definition**

Since the details of laminate definition were discussed previously in example 1, only the final stacking sequences for the laminates required for the blade stiffener are shown below. The laminates are formed from the plies defined in the previous section of this example.

The skin laminate is used in the two plates that form the skin of the blade stiffener.

Example 2: Blade-Stiffened Panel 74
The Flange Laminate is used in the two plates that form the attachment flange.

The Blade Laminate is used in the plate that forms the blade of the stiffener.
Once the laminates are defined, each laminate is associated with the stiffener geometry. A detailed discussion of this process appears in example 1. The plates which form the skin of the blade stiffener are selected with the point-hand tool. Next, the Assign Laminates to Plates option of the Laminates menu is used and the “Skin Laminate” is selected from the laminates window as shown below:

The blade and attachment flange laminates are associated with the structural geometry in an analogous manner. The following two figures show the association of the “Blade Laminate” and the “Flange Laminate” respectively:

Example 2: Blade-Stiffened Panel 76
**Buckling Mode Wavelength**

As discussed previously in example 1, the minimum buckling load half-wavelength, \( \lambda \), is specified using the Eigenvalues menu option of the Panel menu. As in example 1, \( \lambda = 1 \) is specified for the blade stiffened panel.

**Optimization of Stiffener Spacing**

Using MacPASCO, the stiffener spacing can be optimized by selecting appropriate plate widths as design variables and by using linking equations. The MacPASCO display of the blade stiffener is shown below:

In the figure above, plate numbers have been displayed using the Show Plate Numbers option of the View menu. Stiffener spacing can be optimized by choosing the widths of plates 1 and 2 as design variables, and then by using linking equations to ensure that the width of plate 3 is equal to the width of plate 2 and that the width of plate 4 is equal to the width of plate 1.

*Example 2: Blade-Stiffened Panel*
Plate Design Variables

Plate widths are selected as design variables using the Plate Information display. Plate information is displayed by selecting the point-hand tool in the tool palette window and double-clicking on the desired plate, as discussed in example 1. The figure below shows the Plate Information display for plate 1:

The drawing window appears in the background, and the Plate Information display appears in the foreground. Clicking in the box labeled Design Variable makes the plate’s width a design variable. A lower and upper bound for the plate width can also be specified using the keyboard. The figure below shows the Plate Information display after the plate’s width has been made a design variable and given an upper and lower bound:

The width of plate 2 is made a design variable in an analogous fashion.

Example 2: Blade-Stiffened Panel 78
Design Variable Linking Equations

Design variable linking equations are required in this example to enforce the symmetry of the repeating element representing the blade stiffener and skin. Without linking equations, the optimization process would vary the widths of plates 1 and 2, but the widths of plates 3 and 4 would remain fixed. The equations:

\[ \text{width plate 1} = \text{width plate 4} \]
\[ \text{width plate 2} = \text{width plate 3} \]

are required to link the plate widths. Hence the term, linking equation. In MacPASCO, the equivalent equations:

\[ \text{width plate 1} - \text{width plate 4} = 0 \]
\[ \text{width plate 2} - \text{width plate 3} = 0 \]

are created. In addition, certain linking equation variables must be chosen as dependent variables. The values of dependent variables are determined by solving the linking equations using the values of the other independent variables. In this example, the widths of plates 3 and 4 are chosen as dependent variables, and the widths of plates 1 and 2 are independent variables. Hence, as the optimizer varies the width of plate 1, the first linking equation insures an equal width for plate 4, and the second equation links the widths of plates 2 and 3.

MacPASCO offers a graphical linking equation editor for the creation of design variable linking equations. The Linking Equations option of the Optimization menu, shown below, causes the linking equation editor to appear.

When this menu option is selected, the linking equation editor appears as a new window as shown below:

The drawing of the blade stiffener appears on the left, and the linking equation editor appears on the right. For this example, the Show Plate Numbers option of the View menu has been used so that the plate numbers are displayed. The equation editor consists of a box displaying the current equation, which appears above the words, "OK" in the figure. The box is initially blank.

Example 2: Blade-Stiffened Panel 79
The creation of the equation \( \text{width plate 1} - \text{width plate 4} = 0 \) begins by selecting plate 1 in the drawing window with the point-hand tool, and pressing the mouse button while pointing to the box labeled “add plate width” as shown below:

Pressing the mouse button while pointing to the “add plate width” box expands to show a choice of variables. Dimmed items cannot be selected. For example, “add ply thickness” cannot be selected because a ply has not been chosen.

The “add plate width” option is chosen, and when the mouse button is released, plate 1's width is included in the equation as shown below:

\[ \text{Example 2: Blade-Stiffened Panel 80} \]
Next, plate 4 is selected with the point-hand tool and added to the equation in a similar fashion, which results in the display below:

Because Plate 4 is to be used as a dependent variable, the box labeled "Is Dependent Variable" is selected by pointing and clicking with the mouse. Furthermore, since the desired equation is \( width\ \text{plate 1} - width\ \text{plate 4} = 0 \), the keyboard is used to type \(-1\) as the coefficient for the width of plate 4 in the linking equation. The resulting display is shown below:

\[ MP\ Diode \]

\[ \text{Plato Information:} \]
\[ \text{Width: 0.00000000000000000000000000000000} \]
\[ \text{Rotation: 0.00000000000000000000000000000000} \]

\[ \text{Selected Plate = 4} \]
\[ \text{Equation: 1} \]
\[ \text{Coefficient: } -1 \]
\[ \text{Is Dependent Variable} \]

\[ \text{Add Plate Width} \]
\[ \text{Show All Equations} \]

\[ \text{Selected Plate for } MP\ Diode \]
\[ \text{Plate #} \]

\[ \text{Linking Equations} \]

\[ \text{Example 2: Blade-Stiffened Panel 81} \]
Finally, the right-hand side of the equation, $= 0$, is added. First, click to the far right of the equation, so that no equation variables are selected and the coefficient becomes zero, as shown below:

![Equation](image)

Next, use the "add right hand side" option as shown in the first figure below. The resulting final equation is shown in the second figure below:

![Equation](image)

Example 2: Blade-Stiffened Panel 82
The equation \( \text{width plate } 1 - \text{width plate } 4 = 0 \) is complete. The equation \( \text{width plate } 2 - \text{width plate } 3 = 0 \) is created in an analogous manner. The creation of the second equation is initiated by pointing to the box labeled "Next" and pressing the mouse button as shown below:

When the mouse button is released, a blank equation appears in the editor as shown below. The equation number changes from 1 to 2 as an indicator that equation 2 is being edited.

Although this example only used plate widths in linking equations, linking equations can include ply angles and thicknesses also.

**Sizing Cycles**

MacPASCO requires that the user indicate the number of sizing cycles, which determines the number of times the optimization process iterates, using the Optimization Parameters option of the Optimization menu, as discussed in example 1. For this example, two sizing cycles (iterations) are selected.

**Generate PASCO Code**

Finally, the Make PASCO Code option of the File menu is used to generate the PASCO input, as discussed in example 1. The PASCO input file generated by MacPASCO is shown on the following pages. This text file is input to PASCO to analyze and optimize the example panel.
MacPASCO output for Example 2

MP Blade. INPUT
$CONDAT
$
$SPAN

B(1) = -0.8, -0.2, 1.0E30, 1.0E30,
-1.5,
BL(1)=0.001,
BU(1)=10000000000.0,
BL(2)=0.001,
BU(2)=10000000000.0,
BL(5)=0.001,
BU(5)=10000000000.0,
IWALL(1) = 3, 2, 2, 3, 1,
AB(4, 1) = -1.0,
AB(1, 1) = 1.0,
AC(1) = 0.,
AB(3, 2) = -1.0,
AB(2, 2) = 1.0,
AC(2) = 0.,
HCARD(1) = 4, -6, 5, 900, -1,
  2, 121, 6,
  6, 7, 1, 2, 3, -121, 4,
ICARD(1) = 5, 1, 2, 1, -990, 0000,
  3, 2, 4, 2,
  3, 4, 5, 3,
  3, 5, 6, 4,
  3, 3, 4, 6,
  3, 6, -990, 0000,
EL = 30.0,
NX = 3000.0,
NY = 0.,
NXY = 0.,
MX = 0.,
PRESS = 0.,
T(1)=-0.004,
TL(1)=0.0001,
TU(1)=1.0,
THET(1)=45.0,
MAT(1,1)= 1,
TEM(1,1)= 0.,
T(2)=-0.004,
TL(2)=0.0001,
TU(2)=1.0,
THET(2)=45.0,
MAT(2,1)= 1,
TEM(2,1)= 0.,
T(3)=-0.04,
TL(3)=0.0001,
TU(3)=1.0,
THET(3)=0.,
MAT(3,1)= 1,
TEM(3,1)= 0.,
T(4) = -0.01,
TL(4) = 0.0001,
TU(4) = 1.0,
THET(4) = 0.0,
MAT(4, 1) = 1,
TEM(4, 1) = 0.0,
T(5) = -0.003,
TL(5) = 0.0001,
TU(5) = 1.0,
THET(5) = 0.0,
MAT(5, 1) = 1,
TEM(5, 1) = 0.0,
Kwall(1, 1) = 1, -1, -1, 1, 3,
Kwall(1, 2) = 2, -2, -2, 2, 4,
Kwall(1, 3) = 2, -2, -2, 2, 5,
A11U(1) = 1.0E30,
A33U(1) = 1.0E30,
D11U(1) = 1.0E30,
IP = 2,
LINK = 0,
MINLAM = 30,
NOBAY = 16,
ICREP = 16,
MAXJJJ = 2,

$\text{$}

$\text{MATER}$

E1(1) = 1.90000e+7,
E2(1) = 1.89000e+6,
E12(1) = 9.30000e+5,
RHO(1) = 5.71000e-2,
ANU1(1) = 3.10000e-1,
ALFA1(1) = 5.00000e-9,
ALFA2(1) = 2.18000e-5,
ALLOW(1,1) = 2.0, 4.00000e-3, -4.00000e-3, 4.00000e-3,
-4.00000e-3, 1.00000e-2,

$\text{$}
Example 3: Hat-Stiffened Panel

The third example of modeling with MacPASCO is a hat-stiffened metal panel loaded in longitudinal compression. The panel is 20 inches long, has 3 hat stiffeners, and is subjected to a 3000 lb/inch compressive load. The four panel edges are simply supported. The panel is made of 0.02-inch-thick aluminum plates. In this example, the panel is modeled for analysis only. The panel is shown in the figure below (not to scale).

Modeling this hat-stiffened panel illustrates several MacPASCO features that were not shown previously (examples 1 and 2). A different MacPASCO modeling tool is needed to model the hat stiffeners. In addition, this example illustrates the modeling of a metal panel, as opposed to the composite panels modeled previously.

Panel Geometry Modeling

In the case of the hat-stiffened panel, a single hat stiffener is chosen as the repeating substructure which repeats three times across the width of the panel. The dimensions of a single hat stiffener are shown below:
Scaling the Display

The scale of the screen display is chosen to make drawing and manipulating the hat stiffener as convenient as possible. As discussed previously in example 2, the Scale Current View option of the View menu is used to scale the screen display. For this example, the scale is selected as shown below. This scale is the same scale used in example two.

![Scale Display Window]

Drawing the Hat Stiffener

The grab-hand tool is used to change the dimensions of the initial plate element to a width of 3.5 inches, the width of the hat stiffener, as shown below:

![Drawing Plate Element]

Notice that the drawing window scrolls as the mouse is dragged to the right. In the figure on the left, the window has scrolled so far to the right, that the left side of the plate element is no longer visible. The width displayed in the message box is used as a guide.

Example 3: Hat-Stiffened Panel 87
Once the plate element has the proper size, the user adjusts and resizes the window so that the entire plate element is visible, as shown below:

The add-node tool is selected to add nodes to the existing plate. Two nodes are added as shown below, using the plate width and rotation displayed in the message box to guide the placement of the nodes:

In the left-hand picture above, a node has been added which divides the original plate element into two new plate elements. In the right-hand picture, a second node has been added. The result is three plate elements, from left to right, with widths of 1 inch, 1.5 inches, and 1 inch respectively. These plate elements form the skin of the hat stiffener.

Example 3: Hat-Stiffened Panel 88
Next, the add-loop tool is selected from the tool palette and used to add a closed section between two nodes on the existing model. Move the cursor over the second plate element and click the mouse button and a closed section composed of two new plates appears, as shown below:

The left-hand picture shows the cursor positioned over the second plate element. The right-hand picture shows the result of clicking the mouse button.

This closed section is manipulated into the shape of the hat part of the stiffener. First, the grab-hand tool is used to drag the closed section into shape as shown below:
To complete basic geometry of the hat stiffener, another node is added using the add-node tool. The node is dragged into place as it is added, as shown below:

Now the basic geometry of the hat stiffener is complete. The exact widths and rotations must be assigned to the plates forming the stiffener webs and cap. Precise widths and rotations are specified using the Plate Information display.

First the point-hand tool is selected in the tool palette, and then the user double-clicks on a plate as shown below:

In the figure above, the Plate Information display for the darkened plate appears in the foreground.

*Example 3: Hat-Stiffened Panel 90*
The keyboard is used to enter a width of 1 inch and a rotation of -78 degrees, as shown below:

However, when the user clicks on the button labeled "OK" in the Plate Information display, the following dialog box appears:

The dialog box is dismissed by clicking on the button labeled "OK." The error message appears because changes to a plate's width and/or rotation using the Plate Information display should not alter the widths or rotations of any other plates, as discussed previously in this manual. As shown in the figure below, it is not possible to alter the width and/or rotation of a plate in a closed section without altering the width and/or rotation of at least one other plate.

Example 3: Hat-Stiffened Panel 91
In this situation, one can unlock a plate so that the plate dimensions change to accommodate changes to adjacent plates. Plates are unlocked using the Plate Information display. In the figures below, the plate forming the cap of the plate is unlocked by clicking on the box labeled "Lock Plate Geometry." When a cross appears in the box, the plate is locked. When no cross appears, the plate is unlocked. Clicking on a crossed box unlocks the plate and removes the cross. Clicking on an uncrossed box locks the plate and adds the cross.

Once the plate forming the cap is unlocked, the two plates forming the webs of the hat stiffener can be adjusted using the Plate Information display as shown below:

In the left-hand figure above, the dimensions for the left web of the hat are defined. In the right-hand figure, the change to the left web of the hat is visible and one can also see how the cap of the hat has changed dimension to accommodate the change. Also, the dimensions for right web of the hat are defined.

Example 3: Hat-Stiffened Panel 92
The final hat-stiffener geometry is shown in the figure below:

Repeating Elements

The Number of Repeating Elements option of the Panel menu is used to specify that the hat stiffener is repeated three times across the width of the panel. Selecting the Number of Repeating Elements option prompts for the number of repeating elements. The prompting dialog box is shown below after three repeating elements are specified.

Panel Length and Loads

The panel loads and length are specified using the Apply Panel Loads option of the Panel menu. In this case, the panel length is specified as 20 inches and 3000 lb/inch is also entered as the \( N_p \) load as shown below:

Example 3: Hat-Stiffened Panel 93
Boundary Conditions

Boundary conditions on the lateral edges of the panel are specified using the node information dialog box, as discussed previously in this manual. In this case, simple-support boundary conditions are chosen, as shown previously in example 1 of this manual.

Metal Definitions

In the case of metallic panels, MacPASCO (and PASCO) uses a "laminate" of isotropic material. For this example, the hat stiffener is made of 0.02-inch-thick aluminum. First, the material properties for aluminum must be defined, next a single ply of 0.01-inch-thick aluminum is defined, and lastly, a "laminate" composed of two 0.01-inch-thick plies is defined to form a 0.02-inch-thick aluminum "laminate."

As discussed previously in examples 1 and 2, ply materials are defined using the Define Ply Materials option of the Laminates menu. However, MacPASCO includes the material properties of aluminum by default, so no input is required. The figure below shows the default material properties for the aluminum supplied by MacPASCO:

---

Material Name: Aluminum

| E1 | 100000000.0 | AMUI | 0.3 |
| E2 | 100000000.0 | ALFA1 | 0.0 |
| E12 | 5850000.0 | ALFA2 | 0.0 |
| RH0 | 0.1 |

Material Failure Criterion and Allowables

Criterion: Stress

- σ1 compression: 50000.0
- σ1 tension: -50000.0
- σ2 compression: 50000.0
- σ2 tension: -50000.0
- τ12 shear: 40000.0
- F22 shear: 0

Example 3: Hat-Stiffened Panel 94
Next, an aluminum ply is defined using the Define Plies option of the Laminates menu. Since the details of ply definition were discussed previously in the Ply Definition section of example 1, the following figure only shows the ply information display:

![Ply Definition Display](image)

Finally, an aluminum laminate is created using the Define Laminates option of the Laminates menu. Since laminate definition was discussed previously in example 1, only the final stacking sequence is shown below.

![Laminate Definition Display](image)

Example 3: Hat-Stiffened Panel 95
Once the aluminum laminate is defined, it is associated with the stiffener geometry. A detailed discussion of this process appears in example 1. The plates which form the hat stiffener are selected with the point-hand tool. Next, the Assign Laminates to Plates option of the Laminates menu is used and the "Alum" laminate is selected from the laminates window as shown below:

Clicking on the button labeled "OK" assigns the aluminum laminate to the hat stiffener. This process completes the material property definitions required for the hat stiffener.

**Buckling Mode Wavelength**

As discussed previously in examples 1 and 2, the minimum buckling load half-wavelength, $\lambda$, is specified by using the Eigenvalues menu option of the Panel menu. For the hat-stiffened panel, $\lambda = 20$ is specified.

**Generate PASCO Code**

Finally, the PASCO input is generated by using the Make PASCO Code option of the File menu, as discussed in examples 1 and 2. The PASCO input file generated by MacPASCO is shown on the following page. This text file is input to PASCO to analyze and optimize the example panel.
MacPASCO output for Example 3

Hat.INPUT
$CONDAT
$
$SPANEL
B(1) = 1.0, 1.5, 1.0, 1.0, 1.0,
  1.084177, 1.0,
IWALL(1) = 1, 1, 1, 1, 1, 1,
HCARD(1) = 4, -7, 4, 2820, -1,
  4, -8, 6, 780, -1,
  4, 9, 7, 5, 8,
  5, 10, 1, 2, -9, 3,
ICARD(1) = 3, 1, 2, 1,
  5, 2, 5, 2, 3, 7,
  3, 5, 6, 3,
  3, 3, 4, 5,
  3, 4, 5, 8,
EL = 20.0,
NX = 3000.0,
NY = 0.,
NXY = 0.,
MX = 0.,
PRESS = 0.,
T(1)=0.01,
THET(1)=0.,
MAT(I,I)= I,
TEM(I,I)= 0.,
KWALL(I, 1) = 1,
A11U(I) = 1.0E30,
A33U(I) = 1.0E30,
D11U(I) = 1.0E30,
IP = 2,
LINK = 0,
MINLAM = 1,
NOBAY = 3,
ICREP = 3,
$
$MATER
E1(I)= 1.00000e+7,  E2(I)= 1.00000e+7,  E12(I)= 3.85000e+6,
RHO(I)= 1.00000e-1,  ALNU(I)= 3.00000e-1,  ALFA2(I)=0.,
ALFAA2(I)=0.,
ALLOW(I, 1)= 1.0,  5.00000e+4, -5.00000e+4,  5.00000e+4,
  -5.00000e+4,  4.00000e+4,
$

Example 3: Hat-Stiffened Panel 97
References


This document is a user's manual for MacPASCO. MacPASCO is an interactive, graphic, preprocessor for panel design. MacPASCO creates input for PASCO, an existing computer code for structural analysis and sizing of longitudinally stiffened composite panels. MacPASCO provides a graphical user interface which simplifies the specification of panel geometry and reduces user input errors. The user draws the initial structural geometry on the computer screen, then uses a combination of graphic and text inputs to: refine the structural geometry, specify information required for analysis such as panel load and boundary conditions, and define design variables and constraints for minimum-mass optimization. Only the use of MacPASCO is described herein, since the use of PASCO has been documented elsewhere.